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Notice
Every effort was made to ensure that the information in this document 
was complete and accurate at the time of printing. However, information 
is subject to change.

Preventing Toll Fraud
“Toll fraud” is the unauthorized use of your telecommunications system 
by an unauthorized party (for example, a person who is not a corporate 
employee, agent, subcontractor, or working on your company's behalf). 
Be aware that there may be a risk of toll fraud associated with your 
system and that, if toll fraud occurs, it can result in substantial additional 
charges for your telecommunications services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1 800 643 2353 for the United States and 
Canada. For additional support telephone numbers, see the Avaya Web 
site:
http://www.avaya.com 

Select Support, then select Escalation Lists US and International. 
This Web site includes telephone numbers for escalation within the 
United States. For escalation telephone numbers outside the United 
States, select Global Escalation List.

Providing Telecommunications Security
Telecommunications security (of voice, data, and/or video 
communications) is the prevention of any type of intrusion to (that is, 
either unauthorized or malicious access to or use of) your company's 
telecommunications equipment by some party.
Your company's “telecommunications equipment” includes both this 
Avaya product and any other voice/data/video equipment that could be 
accessed via this Avaya product (that is, “networked equipment”).

An “outside party” is anyone who is not a corporate employee, agent, 
subcontractor, or working on your company's behalf. Whereas, a 
“malicious party” is anyone (including someone who may be otherwise 
authorized) who accesses your telecommunications equipment with 
either malicious or mischievous intent.

Such intrusions may be either to/through synchronous (time-multiplexed 
and/or circuit-based) or asynchronous (character-, message-, or packet-
based) equipment or interfaces for reasons of:

• Utilization (of capabilities special to the accessed equipment)
• Theft (such as, of intellectual property, financial assets, or 

toll-facility access)
• Eavesdropping (privacy invasions to humans)
• Mischief (troubling, but apparently innocuous, tampering)
• Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)

Be aware that there may be a risk of unauthorized intrusions associated 
with your system and/or its networked equipment. Also realize that, if 
such an intrusion should occur, it could result in a variety of losses to your 
company (including but not limited to, human/data privacy, intellectual 
property, material assets, financial resources, labor costs, and/or legal 
costs).

Your Responsibility for Your Company’s Telecommunications 
Security
The final responsibility for securing both this system and its networked 
equipment rests with you - an Avaya customer's system administrator, 
your telecommunications peers, and your managers. Base the fulfillment 
of your responsibility on acquired knowledge and resources from a 
variety of sources including but not limited to:

• Installation documents
• System administration documents
• Security documents
• Hardware-/software-based security tools
• Shared information between you and your peers
• Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and 
your peers should carefully program and configure:

• your Avaya-provided telecommunications systems and their 
interfaces

• your Avaya-provided software applications, as well as their 
underlying hardware/software platforms and interfaces

• any other equipment networked to your Avaya products.
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Microsoft, MS, MS-DOS, Windows, Windows 95, Windows 98, Windows 
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Professional are registered trademarks of Microsoft Corporation
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Avaya Support
Avaya provides a telephone number for you to use to report problems or 
to ask questions about your contact center. The support telephone 
number is 1-800-242-2121 in the United States. For additional support 
telephone numbers, see the Avaya Web site:

http://www.avaya.com 
Select Support, then select Escalation Lists US and International. 
This Web site includes telephone numbers for escalation within the 
United States. For escalation telephone numbers outside the United 
States, select Global Escalation List.
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Chapter 1: About this information product

Purpose 

The CentreVu  IP Agent, Version 2 Installation and User Guide includes information that 
you need to know in order to install and use CentreVu  IP Agent, Version 2. It also 
provides information on features, basic operation, and administrative tasks.

This is issue 1.2 of this document.

Intended audience

This guide is intended for anyone who is installing and/or using the CentreVu  IP Agent, 
Version 2 software and performing station administration on the DEFINITY  ECS 
(Enterprise Communications Server). It assumes that you are familiar with:

● The computer on which CentreVu  IP Agent, Version 2 will be installed and run.

● Microsoft Windows  95, Microsoft Windows  98, Microsoft Windows  Millennium 
Edition, Microsoft Windows  2000, Microsoft Windows NT  4.0 , or Microsoft Windows  
XP operating systems

● standard Microsoft Windows  conventions

● Call center configurations and operations
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Conventions used

The following conventions are used in this document:

Related documents

The following list provides the documents that can help you in the configuration and use of 
CentreVu  IP Agent, Version 2.

● DEFINITY  Enterprise Communications Administrator’s Guide

● DEFINITY  Enterprise Communications Server Automatic Call Distribution (ACD) 
Supervisor Instructions

● DEFINITY  Enterprise Communications Server Automatic Call Distribution (ACD) 
Agent Instructions

To register for instructor-led courses, call

1–800–255–8988

To order CD-ROM courses, call

1–800–225–7585

Inquiries for training originating outside the United States and Canada should call

(1) (904) 636–3261

Convention Description

Initial Capital Letters Names of windows, dialog boxes, and 
keyboard keys. For example, The Name field 
is in the Properties dialog box.

<KEY>+<KEY> Key combinations for which you must press 
and hold down one key and then press 
another key at the same time. For example, 
<Ctrl>+<F4> means that you press the Ctrl 
key and the F4 key at the same time.

Italic Text Indicates references to other documents, 
products, trademarks, and also used for 
emphasis.

“ ” Sections and chapters that are referenced. 
For example, See “Chapter 2, Installing and 
uninstalling CentreVu  IP Agent, Version 2”, 
for information on how to install the software.
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To order documents by telephone:

GlobalWare Solutions
Voice: 1-800-457-1235 or international voice: +1 410 568-3680
Fax: 1-800-457-1764 or international fax: +1 410 891-0207

To order documents by mail:

GlobalWare Solutions
200 Ward Hill Avenue
Haverhill, MA 01835
USA

The ordering information for this document:

Document 585-215-713
Issue 1.2, August 2002

You can be placed on a Standing Order list for this and other documents you may need. 
Standing Order will enable you to automatically receive updated versions of individual 
documents or document sets, billed to account information that you provide. For more 
information on Standing Orders, or to be put on a list to receive future issues of this 
document, please contact the Avaya Publications Center.
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Chapter 2: Introduction

This chapter provides introductory and basic information about CentreVu  IP Agent, 
Version 2.

This chapter includes the following sections:

● What is CentreVu IP Agent? on page 16

● CentreVu IP Agent configurations on page 18

● Compatible phone types for CentreVu IP Agent V2 on page 21

● Other considerations on page 22
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What is CentreVu IP Agent?

Description

CentreVu  IP Agent is a software application that provides advanced telephony features 
for agents in a contact center. It also allows agents to work on-site at the contact center, 
off-site using Voice over Internet Protocol (VoIP), or off-site using analog connections over 
a Public Switched Telephone System (PSTN). The advanced telephony features are 
controlled by CentreVu  IP Agent through its direct communcation with the DEFINITY  
ECS.

Features

The following list provides the main features of CentreVu  IP Agent:

● Agents who are not located at the contact center can connect to the DEFINITY  ECS in 
the contact center and receive calls as if they were present at their contact center 
workstation. For example, if an agent cannot travel to the contact center because of 
transportation problems or weather conditions, they can still take calls by using 
CentreVu  IP Agent to connect to the DEFINITY  ECS.

● Agents using an analog telephone can still use the advanced call features provided by 
the DEFINITY  ECS. For example, an agent working from home can still use such 
features as call transfer, placing a call on hold, and changing their agent state through 
their own telephone.

● “Screen pops” can be initiated when a call is received or placed by the agent. 
CentreVu  IP Agent provides you with the ability to display webpages, start 
applications, or retrieve and display customer information from a database. A screen 
pop can consist of any process or application that can be initiated through one of the 
commands in the following list:

— Windows® “Open” command

— Dynamic Data Exchange (DDE) “execute” or “poke” commands

● A complete call history is provided for incoming and outgoing calls; even for those 
missed calls where the caller does not leave a voice message.

● A customizable telephone directory is provided that lists addresses, multiple telephone 
numbers, speed-dial numbers, e-mail, and notes for each contact.

● CentreVu  IP Agent provides the ability to search through public or company 
information using the Lightweight Directory Access Protocol (LDAP).

● CentreVu  IP Agent provides a compact, but instinctive, graphical user interface.
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New features for CentreVu IP Agent, Version 2

The following list provides the new features for CentreVu  IP Agent, Version 2:

● Road-Warrior configuration (Voice over IP) — Agents can connect to the DEFINITY  
ECS using their PC and an IP network connection. In this configuration, a telephone set 
is not necessary as all audio is performed through the sound card of the PC.

● Agent greetings — Multiple agent greetings can be recorded and configured to play 
based on such variables as login status, agent state, agent ID, prompted digits, 
Automatic Number Identification (ANI) or Vector Directory Number (VDN). This feature 
is only available for CALLMASTER  VI and Road-Warrior (VoIP) configurations.

● Feature Deactivation — Administrators can deactivate CentreVu  IP Agent features 
that should not be configured or used by agents. The features that can be deactivated 
include screen pops, screen pop administration, phone directory, public search 
directory, call history, phone features configuration, personal phone features, program 
options, and agent greeting selection.

● Screen Pop Wizard — This new wizard guides you through the creation of screen pops. 
This wizard makes configuring screen pops much more simple.

● VDN screen pops — Specific “screen pops” can be activated based on the VDN on 
which a call was received.

● Speed dialer — Telephone numbers can be entered and assigned to function keys 
(<F2>, <F3>, ..., <F8>).

● VuStats support — CentreVu  IP Agent can display multiple lines of VuStats information 
in the a dialog that helps provide complete monitoring of the contact center.

● Clipboard dialing — CentreVu  IP Agent can dial any number copied to the clipboard or 
a number that is highlighted in most applications on the PC.

● Configurable database location — You can now change the location where the 
CentreVu  IP Agent database is stored. This database contains the phone directory and 
the call history information.

● Enhanced telephone features — The telephone features now support the addition, 
renaming, and deletion of folders.

● Enhanced system tray icon — The “Answer” icon in the Microsoft Windows  system 
tray has been enchanced to provide release, drop, hold, transfer, and conference 
functions.

● Drag and drop functions — The transfer and conference functions can now be done by 
using drag-and-drop.

● Automatic login — An agent can now log in to the ACD automatically when CentreVu  
IP Agent is started and uses the login information from the previous login.
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CentreVu IP Agent configurations

Introduction

CentreVu  IP Agent, Version 2 supports three different configurations:

● Road-Warrior configuration (Voice over IP) on page 18

● Telecommuter (dual connection) on page 19

● CALLMASTER VI (DCP connection) on page 19

Road-Warrior configuration (Voice over IP)

This configuration is used in situations where a PC can make a dial-up or network 
connection to a DEFINITY  ECS. A telephone set is not used in this configuration which is 
valuable in those situations where a telephone set is not available or it is not cost-effective 
to have one available. All of the features of the DEFINITY  ECS are available to the agent 
through this type of connection. The single network connection between the PC running 
CentreVu  IP Agent and the DEFINITY  ECS carries two channels; one for signaling 
(data) and one for voice. CentreVu  IP Agent controls the data flow while the DEFINITY  
iClarity IP Audio (an H.323 V2–compliant audio application) handles the voice 
communications. This type of configuration provides the best IP audio quality that is 
possible with your connection speeds and network setup. The agent places and receives 
calls through the CentreVu  IP Agent interface using a headset connected to the PC to 
speak and listen. 

What you need to know

The following list provides the requirements and capabilities in this configuration:

● Connection — One dial-up or network connection from the PC with CentreVu  IP Agent 
to the DEFINITY  ECS

● PC hardware — Sound card (full-duplex recommended) and Modem or Network 
Interface Card for connectivity to the DEFINITY  ECS

● Telephone set — Not supported in this configuration

● Voice Quality — Dependent on the performance of the PC hardware and the amount of 
bandwidth available in the network connection

● Agent Greetings — Stored on the PC

● Right-To-Use DEFINITY  connections — Two station RTUs (One for the signaling path 
and one for the IP audio path)
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Telecommuter (dual connection)

This configuration is used in situations where a PC can make a dial-up or network 
connection to a DEFINITY  ECS for the signaling (data) path and a voice path through a 
telephone set. The telephone set can be an analog telephone, a cellular telephone, or an 
extension on a local switch. Using this configuration provides toll-quality audio and full 
telephony functionality through CentreVu  IP Agent. Calls are placed and received 
through the CentreVu  IP Agent interface and the voice path is sent to the telephone. 
Agent greetings cannot be supported in this configuration because the greetings reside on 
the PC and cannot connect to the voice path.

What you need to know

The following list provides the requirements and capabilities in this configuration:

● Connection — One dial-up or network connection from the PC installed with CentreVu  
IP Agent to the DEFINITY  ECS and a telephone capable of receiving calls through the 
DEFINITY  ECS

● PC hardware — Modem or Network Interface Card (NIC) for connection to the 
DEFINITY  ECS

● Telephone set — Any telephone capable of placing and receiving calls from the 
DEFINITY  ECS

● Voice Quality — High

● Agent Greetings — Not supported in this configuration

● Right-To-Use DEFINITY  connections — One station RTU for signaling connection and 
one of the following:

— For off-site use, one port RTU

— For on-site use, one station RTU

CALLMASTER VI (DCP connection)

The CALLMASTER  VI is a small telephone set with 8 buttons, 2 headset jacks, DCP 
connectivity, and is connected to a PC through a serial (RS-232) connection. This 
configuration is intended for usage at the desk of an agent in the contact center. 
Functionality is provided through a DCP connection to the DEFINITY  ECS and does not 
require a TCP/IP network connection. 
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What you need to know

The following list provides the requirements and capabilities in this configuration:

● Connection — DCP connection for the CALLMASTER  VI telephone set and a serial 
(RS-232) connection between the CALLMASTER  VI and the PC

● PC hardware — Serial (RS-232) port

● Telephone set — CALLMASTER  VI

● Voice Quality — High

● Agent Greetings — Stored on the CALLMASTER  VI telephone set

● Right-To-Use DEFINITY  connections — One station RTU
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Compatible phone types for CentreVu IP Agent V2

Supported phone types

The following table lists the phone types that can be set on the DEFINITY  system and 
that Avaya supports for use with CentreVu  IP Agent, Version 2:

* This phone type is capable of displaying 80 characters.

Recommended phone types

While all of the phone types listed in the previous table work with CentreVu  IP Agent, 
Version 2, the following phone types provide the most buttons, features, and the largest 
area of display:

● 606A1

● 8434D

Because of the larger number of characters used for display, these phone types are better 
suited to handle VuStats or Prompted Digits information.

CALLMASTER II—602A1* 6416D+

CALLMASTER III—
603A1*, 603D1*, and 603E1*

6416D+ with expansion module

CALLMASTER IV—603F1* 6424D+

CALLMASTER V—607A1 6424D+ with expansion module

CALLMASTER VI—606A1* 8405D

4606 8405D+

4612 8410D

4624 8411D (For this telephone set, you 
must disable the data port, which is 
true for all softphones.)

6408D 8434D*

6408D+ 8434D* with expansion module
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Other considerations

Co-residence with DEFINITY  IP SoftphoneTM 

You can install CentreVu  IP Agent using an IP endpoint on a PC on which DEFINITY  IP 
Softphone R2 is installed. You can run either program, but you cannot run them at the 
same time. You cannot run CentreVu  IP Agent with an extension that is currently 
registered as an DEFINITY  IP Softphone endpoint on the same PC. If the extension is 
registered as a DEFINITY  IP Softphone endpoint, you must log out and exit the 
registration program before starting CentreVu  IP Agent.

You cannot install CentreVu  IP Agent using a CALLMASTER  VI endpoint on a PC that 
currently has DEFINITY  IP Softphone R2 installed.

Network compatibility

CentreVu  IP Agent does not support Network Address Translation (NAT), Port Address 
Translation (PAT), or unsupported Virtual Private Network (VPN).

Dialing emergency numbers

CentreVu  IP Agent can dial emergency calls such as 911 calls in the United States; 
however, the call will only reach the local emergency service in the Public Safety 
Answering Point area where the DEFINITY  ECS is located.

From locations outside the contact center, CentreVu  IP Agent will not dial to and connect 
with local emergency services. Therefore, you should not use CentreVu  IP Agent to dial 
emergency numbers when dialing from remote locations.

! Important:
Avaya will not be responsible or liable for any damages or injuries resulting 
from misplaced emergency calls made from CentreVu  IP Agent. Your use 
of this product indicates that you have read this advisory and agree to use 
an alternative telephone to dial all emergency calls from remote locations.
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Chapter 3: Installing and uninstalling 
CentreVu IP Agent

This section contains the procedures and important information for installing and 
uninstalling CentreVu  IP Agent, Version 2.

This section includes the following topics:

● Prerequisites on page 25

● Installing CentreVu IP Agent V2 on page 31

● Upgrades and reinstallation on page 39

● Uninstalling CentreVu IP Agent V2 on page 43

CentreVu IP Agent software CD-ROM contents

The CentreVu  IP Agent, Version 2 CD-ROM contains the following:

● CentreVu  IP Agent, Version 2 installation program

● CentreVu  IP Agent, Version 2 program files

● Documentation in PDF format — Adobe Acrobat  Reader 3.0 or later is required to view 
PDF documents.

● A readme.txt file that contains last minute information
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Prerequisites

This section provides information on the necessary hardware and software required for 
successful installation and use of CentreVu  IP Agent.

This list provides the minimum or recommended requirements for following areas:

● DEFINITY system on page 26

● Personal computer hardware on page 26

● Personal computer software on page 28

● Voice-over-IP considerations on page 28
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Requirements
This section provides specific information regarding the minimum requirements for 
successful installation and use of CentreVu  IP Agent, Version 2.

DEFINITY system

CentreVu  IP Agent, Version 2 requires one of the following DEFINITY  ECS depending 
on the configuration used:

● Telecommuter configurations — A DEFINITY  Enterprise Communication Server (ECS) 
release 8.2 or later with the C-LAN circuit pack.

● Road-Warrior (VoIP) configurations — A DEFINITY  Enterprise Communications 
Server (ECS) release 8.2 or later with the C-LAN and IP Media Processor circuit packs.

● CALLMASTER  VI configurations — A DEFINITY  ECS with software release 6.2 or 
later

Personal computer hardware

The following list provides the minimum PC hardware requirements for CentreVu  IP 
Agent, Version 2:

Processor

An x86 processor at 200 MHz or faster is required. For Road-Warrior (VoIP) configurations, 
a minimum of a 300 MHz processor is required.

Hard disk space

CentreVu  IP Agent requires a minimum of 30 MB. CentreVu  IP Agent could require 
more hard disk space depending on the amount of data you store for the phone directory, 
call history, and screen pops.

RAM

Road-Warrior (VoIP) configurations:

● Microsoft Windows  XP, Microsoft Windows  2000 — 128 MB

● Microsoft Windows  98, Microsoft Windows  Millennium Edition, and Microsoft 
Windows NT  4.0 — 64 MB
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● Microsoft Windows  95 — Unsupported

Telecommuter (dual-line) configurations:

● Microsoft Windows  XP, Microsoft Windows  2000, and Microsoft Windows NT  4.0 — 
64 MB

● Microsoft Windows  98 and Microsoft Windows  Millennium Edition — 32 MB

● Microsoft Windows  95 — Unsupported

CALLMASTER  VI configurations:

● Microsoft Windows  XP, Microsoft Windows  2000 and Microsoft Windows NT  4.0 — 
64 MB

● Microsoft Windows  98 and Microsoft Windows  Millennium Edition — 32 MB

● Microsoft Windows  95 — 32 MB

Audio

Road-Warrior (VoIP) configurations require a sound card and a headset or 
speakers/microphone. It is recommended that you use a sound card that supports full-
duplex operation for maximum voice quality. Use of a headset will provide higher voice 
quality than that of speakers and a microphone.

For a list of the laptops, sound cards, and headsets supported by CentreVu  IP Agent, go 
to http://support.avaya.com.

Note:
Only the Road-Warrior configuration supports the use of a microphone 
through the PC.

Networking

The following list provides the network requirements for each configuration type:

● For Road-Warrior (VoIP) configurations, a single network connection between the PC 
and the DEFINITY  ECS is required.

● For Telecommuter configurations, one network connection and one telephone 
connection are required.

● For CALLMASTER  VI configurations, a Digital Communcations Protocol (DCP) 
connection to the DEFINITY  ECS and a serial (RS-232) connection between the PC 
and the CALLMASTER  VI telephone set is required.
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Peripherals

The following peripherals are required for installation and usage of CentreVu  IP Agent:

● CD-ROM drive for installation

● Mouse or compatible pointing device

Personal computer software

CentreVu  IP Agent, Version 2 requires the following software:

● A Microsoft WindowsTM operating system from the following list:

— Windows 95 (Supports only the CALLMASTER  VI configuration)

— Windows 98 Microsoft Windows  98

— Windows Millennium Edition (ME)

— Windows NT 4.0 Workstation and Server with Service Pack 4 (SP4) or later

— Windows 2000 Professional and Server

— Windows XP Home and Professional

● Microsoft Internet Explorer 4.0TM or later is required for viewing the online help for 
CentreVu  IP Agent.

! Important:
Microsoft Windows 2000 Advanced ServerTM and Windows 2000 
Datacenter ServerTM are not supported.

CentreVu  IP Agent does not support usage through Terminal Services on 
Windows 2000 Server or Windows NT Terminal Server.

Voice-over-IP considerations

Voice communication through Internet Protocol requires consistent, non-restrictive network 
bandwidth as well as the PC hardware sufficient to support not only the communications of 
the agent but also other tasks. If you experience problems with Avaya™ IP Agent Voice-
over-IP telephony, you should ensure that network and PC resources are adequate for the 
tasks being performed.

Voice-over-IP uses real-time processing on your PC to transmit voice communication. 
Nearly all other processes on a PC use sequential processing meaning that requests for 
system resources are processed as they become available. If resources are not available 
to process Voice-over-IP actions, the quality of the communication degrades.

Network bandwidth availability can also have an impact on Voice-over-IP communications. 
The codecs used for Voice-over-IP encoding can vary from using small packets for dial-up 
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connections with reduced voice quality to using larger packets providing higher voice 
quality over broadband and high-speed connections.

The PC software and hardware requirements for Avaya IP Agent are the absolute 
minimum needed for operation. If you experience problems with Voice-over-IP beyond 
those of configuration, most can be solved by upgrading system or using one with higher 
specifications.

Troubleshooting

The speed of a processor is a consideration when you are troubleshooting Voice-over-IP 
difficulties. However, architecture must also be considered. Both Intel® and AMD® have 
produced economical processors for small business and home users that, while rated at 
comparable speeds to the higher-priced models, have reduced on-chip memory (L1/L2 
cache). This affects real-time processing which, in turn, affects Voice-over-IP 
communications. Additionally, some chip sets have been created which include specialized 
instruction sets that optimize specific types of applications and processes. These include 
speech processing.

If you are experiencing problems with Voice-over-IP communications with IP Agent, using 
a system with higher specifications for the items listed below is recommended.

● Processor speed

● On-chip memory (L1/L2 cache)

● System Bus speed

Note:
Avaya IP Agent does not officially support Cyrix™ processors.

Systems

The following system descriptions are meant as a guideline for determining if higher 
system requirements are necessary for Voice-over-IP communications. If your system 
more closely resembles the moderate- or high-demand systems, an upgrade is 
recommended.

Specific requirements for each type of system cannot be given because RAM, processor 
speed, system bus speed, on-chip memory, sound cards, network bandwidth, and 
applications in use are all variables that can range greatly in their impact.

High-demand – A high-demand system is a PC that uses processor-intensive 
applications.

The following list presents some examples of activities and applications that are used in a 
high-demand system:

● Multiple, CPU-intensive applications running simultaneously
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● Database queries/hosting

● Multimedia applications

● Computer-Assisted Drafting (CAD) applications

● Compilers

● Streaming media

Moderate-demand – A moderate-demand system is a PC that sometimes uses 
applications normally found in an office environment.

The following list presents some examples of activities and applications that are used in a 
moderate-demand system:

● Word processors

● Spreadsheets

● Web browsing

● Data entry

● General e-mail

Low-demand – A low-demand system is a PC that rarely uses any applications apart from 
Avaya IP Agent.

The following list presents some examples of activities and applications that are used in a 
low-demand system:

● Text e-mail

● Simple web browsing (no streaming media)

● Minimal data entry
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Installing CentreVu IP Agent V2

This section provides the procedure for installing CentreVu  IP Agent, Version 2 on a 
personal computer.
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Performing the installation

Before you begin

Ensure that you have done the following before you attempt to install CentreVu  IP Agent, 
Version 2:

● Close all applications.

● Insert the CentreVu  IP Agent, Version 2 CD-ROM in the CD-ROM drive.

● Read the readme.txt file in the root directory of the CentreVu  IP Agent, Version 2 CD-
ROM.

Distributed installation

If you wish to install CentreVu  IP Agent on PCs that are not equipped with a CD-ROM 
drive, you can copy the contents of the CD-ROM to a network location. Running the install 
program from the network does not alter the installation program.

Steps

To install CentreVu  IP Agent, Version 2, perform the following steps:

1. If the CentreVu  IP Agent, Version 2 installation program did not begin after the CD-
ROM was inserted, execute the SETUP.EXE file in the root directory of the CD-ROM.

The system displays the Welcome window.

2. Select Next >.

The install program displays the Software License Agreement window.



Performing the installation

Issue 1.2 August 2002 33

3. Select Yes to accept all the terms of the Software License Agreement. Selecting No 
will cause the installation program to exit.

The install program displays the Select Configuration window.

4. Select one of the following options:

● IP Endpoint — This option is used for LAN and dial-up connections. This option is 
not supported on Microsoft Windows  95.

● CALLMASTER VI Endpoint — This option is used for PCs connected through a 
serial connection to a CALLMASTER  VI terminal.

This option is only valid for those call centers using CALLMASTER  VI terminals and 
the 606A1 phone type on the DEFINITY  ECS which requires that the PASTE (PC 
Application Software Translation Exchange) customer option is enabled.

! Important:
If you are reinstalling CentreVu  IP Agent, Version 2, the Endpoint 
previously configured on the PC will be selected by default. To change 
Endpoint type, the currently installed CentreVu  IP Agent must be removed. 
The install program can remove the previous version of CentreVu  IP 
Agent. If you choose the type of Endpoint that is not currently used, the 
install program displays a message box asking if the current version should 
be removed. Selecting Yes will remove the current version and the 
installation continues.
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5. If you selected IP Endpoint in the previous step, the install program displays a 
message box asking if you wish to have CentreVu  IP Agent set to Auto-Answer.

Select Yes to have CentreVu  IP Agent automatically connect the agent to incoming 
calls without requiring interaction with the telephone set or CentreVu  IP Agent.

If you do not wish to have this option enabled, select No

The Auto-Answer feature requires that DEFINITY  ECS configuration for this station is 
also set for auto-answer. Failure to have this option set in both CentreVu  IP Agent 
and the DEFINITY  ECS can result in problems during agent login or when answering 
incoming calls.

6. Select Next >.

If you selected the CALLMASTER VI Endpoint configuration, the install program 
displays the Provide PASTE Feature Access Code window.

The PC Application Software Translation Exchange (PASTE) is a DEFINITY  ECS 
feature that uses the CALLMASTER  VI terminal to pass software translation 
information to CentreVu  IP Agent.

7. Enter the PASTE Feature Access Code in the provided field. If you do not know the 
PASTE Feature Access Code at the time of installation, leave this field blank. You can 
enter this code at a later time in Program Options.

You can find the PASTE Feature Access Code in the Feature Access Code (FAC) form 
on the DEFINITY  ECS. For more information on the PASTE Feature Access Code, 
see the DEFINITY  Enterprise Communications Server Administrator’s Guide for your 
specific DEFINITY  ECS.
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8. Select Next >.

The install program displays the Choose Destination Location window.

9. If you wish to install CentreVu  IP Agent, Version 2 in a folder other than the default, 
click the Browse button in the Destination Folder box.

10. When you are satisfied with the folder in which CentreVu  IP Agent, Version 2 will be 
installed, click Next >.

The install program displays the Setup Type window.

11. In the Setup Type window, select one of the following options and then click Next >:

● Typical — This option installs the basic options in English as well as the basic 
options in the language of your Microsoft Windows  operating system.

● Custom — This option installs the basic options in English as well as the basic 
options in any language you choose.

If you selected the Custom option, you will be presented with the Select Components 
window that allows you to specify the software components to install. Proceed with the 
next step.

If you selected the Typical option, go to Step 16.

12. Indicate the components to install by selecting the check box next to the option.

When selecting the components to install, ensure that the Space Required does not 
exceed the Space Available that is indicated at the bottom of the window.

13. Select Next >.

The install program displays the Select Program Folder window.

14. The Select Program Folder window allows you to choose one of the following 
methods to specify the folder name that will appear in the Start Menu:

● You can accept the default CentreVu  IP Agent, Version 2 folder name that appears 
in the Program Folders: field.
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● You can enter a different folder name in the Program Folders: field.

● You can select an existing folder in the Existing Folders: field in which to install the 
CentreVu  IP Agent, Version 2 shortcuts.

15. Select Next >.

The install program displays the Select Program Shortcuts window.

16. Select the check box next to the shortcut options you wish to occur.

Note:
If you select a shortcut location but do not select any language, the install 
program displays a warning that you need to select at least one or more 
language.

17. If you selected one of the check boxes on this dialog, you must highlight a language in 
the Select the languages you would like to have added list box for the shortcuts to 
be created in that language.

18. If you would like CentreVu  IP Agent, Version 2 to run automatically when Microsoft 
Windows  is started, select the check box for Automatically start the following 
version of CentreVu IP Agent when Windows is started: and then select the 
language from the drop-down list.

! Important:
You must establish a connection to your corporate network before logging in 
to the DEFINITY  ECS with CentreVu  IP Agent. If you are using a dial-up 
modem with a dynamically-assigned IP address, do not select this option.
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19. Select Next >.

The install program displays the Start Copying Files window.

This window displays the options that you have selected. If you need to make any 
changes to the selections you made, select the < Back button until you reach the 
necessary window.

20. When you are satisfied with the specified options, select Next >.

The install program begins copying files. When this process is complete, the install 
program displays the CentreVu IP Agent Completion Status window which displays 
the progress of CentreVu  IP Agent, Version 2 installation and configuration.

Note:
If you are performing an installation for a CALLMASTER  VI, the install 
program displays the Select Communication Port window. If the 
installation type is IP Endpoint, this dialog is not displayed. 

21. For CALLMASTER  VI installations, select the communciations (COM) port that is 
used to connect to the CALLMASTER  VI. If you are performing an IP Endpoint 
installation, skip this step.

When the configuration of CentreVu  IP Agent, Version 2 is complete, the install 
program displays the View the Release Information File window.

22. Select the check box provided in the View the Release Information File window to 
view the release information for CentreVu  IP Agent, Version 2.

23. Select Next >.

The install program displays the readme.txt file.

24. When you have read the readme.txt file, close the application displaying it.

The install program displays the Setup Complete window.

25. In the Setup Complete window, select one of the following options:
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● Yes — This option will automatically close all currently running applications and 
restart the computer.

● No — This option allows you to continue working without restarting your computer.

! Important:
You must restart your computer before running CentreVu  IP Agent, Version 
2.

26. Select Finish.

The install program completes and performs a restart of the computer if you selected 
that option.
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Upgrades and reinstallation

This section provides information for when you install CentreVu  IP Agent, Version 2 over 
a previous version of CentreVu  IP Agent, such as V1 or V1.1.

This section contains the following topics:

● Upgrading or CentreVu IP Agent V1.X to V2 on page 40

● Reinstalling CentreVu IP Agent V2 on page 41
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Upgrading or CentreVu IP Agent V1.X to V2
This section provides information when upgrading CentreVu IP AgentV1.X to CentreVu  
IP Agent, Version 2.

The installation procedure for upgrading to CentreVu  IP Agent, Version 2 is the same as 
listed in the Performing the installation section except for the following:

● You cannot change the installation directory for CentreVu  IP Agent.

Data migration

The following list describes the areas of customizable data and how the upgrade process 
to CentreVu  IP Agent, Version 2 affects each one:

● Call History — The call history is completely migrated during an upgrade.

● Phone Directory — The phone directory is completely migrated during an upgrade.

● Program Options — The settings you have configured for previous versions are 
completely migrated during an upgrade.

● Public Search Directory — LDAP servers and the associated settings are completely 
migrated during an upgrade.

● Screen Pops — Screen pops cannot be migrated automatically during an upgrade. You 
must recreate your screen pops manually in CentreVu  IP Agent, Version 2. However, 
once you have recreated the screen pops on one PC, you can export this information 
using the File > Export option from the menu bar and then import it into the remaining 
CentreVu  IP Agent, Version 2 PCs.

● Personalized Phone Labels — If you changed the name of a feature listed in the Phone 
Features or Personal Phone Features, these names cannot be saved during an 
upgrade. You will need to rename these features in CentreVu  IP Agent, Version 2.

● Personal Phone Features — Any features copied to the Personalized Phone Features 
window are not saved during an upgrade. These entries must be manually copied to this 
window again.
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Reinstalling CentreVu IP Agent V2
This section provides information for those times when you are reinstalling or upgrading to 
a later release of CentreVu  IP Agent, Version 2.

When you are reinstalling CentreVu  IP Agent, Version 2, the current endpoint 
configuration of the previous version is automatically selected during installation. Other 
than this difference, the installation procedure is the same as listed in the Performing the 
installation section.

! Important:
During a reinstall, the install program prompts you to remove the current 
version of CentreVu  IP Agent, Version 2. If you cancel the installation and 
uninstall CentreVu  IP Agent manually, you will lose most of your current 
information, including call history, phone directory, and screen pops. To 
preserve your current CentreVu  IP Agent information, continue the 
installation when the first warning appears. Another prompt appears during 
installation which asks if the install program should automatically remove the 
previous version. Allowing the install program to remove the previous 
version preserves your data.

Data migration

The following list of information is migrated during a reinstall of CentreVu  IP Agent, 
Version 2:

● Call History — The call history is completely migrated during a reinstall.

● Phone Directory — The phone directory is completely migrated during a reinstall.

● Program Options — The settings you have configured for previous versions are 
completely migrated during a reinstall.

● Public Search Directory — LDAP servers and the associated settings are completely 
migrated during a reinstall.

● Screen Pops — Screen pops cannot be migrated automatically during a reinstall. You 
must recreate your screen pops manually in CentreVu  IP Agent, Version 2. However, 
once you have recreated the screen pops on one PC, you can export this information 
using the File > Export option from the menu bar and then import it into the remaining 
CentreVu  IP Agent, Version 2 PCs.

● Personalized Phone Labels — If you changed the name of a feature listed in the Phone 
Features or Personal Phone Features, these names cannot be saved during an 
upgrade. You will need to rename these features in CentreVu  IP Agent, Version 2.
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● Personal Phone Features — Any features copied to the Personalized Phone Features 
window are not saved during an upgrade. These entries must be manually recreated 
and copied to this window again.

● Custom Lists — Folders and items within the folders that you have created for your 
Phone Features are not saved during an upgrade. These folders and items must be 
manually recreated.
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Uninstalling CentreVu IP Agent V2 

This section explains how to uninstall CentreVu  IP Agent, Version 2.

You can easily uninstall CentreVu  IP Agent, Version 2 using the Windows Add/Remove 
Programs wizard. The uninstall program removes the CentreVu  IP Agent, Version 2 files 
including all installed languages, the folders associated with CentreVu  IP Agent, Version 
2, the DEFINITY  IP Service Provider, and the DEFINITY  iClarity IP Audio component 
from the computer. Read-only folders that are shared with other applications are not 
removed.
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Performing the uninstall

Steps

To uninstall the CentreVu  IP Agent, Version 2 application, perform the following steps:

1. Close CentreVu  IP Agent, Version 2 if it is currently running.

2. From the Control Panel, double-click the Add/Remove Programs icon. Microsoft 
Windows  displays the Add/Remove Programs Properties dialog box.

3. On the Install/Uninstall tab, find and highlight Avaya CentreVu IP Agent in the list 
box.

4. Select the Add/Remove... button.

Microsoft Windows  displays the Confirm File Deletion message box.

5. Select Yes.

The unInstallShieldwizard begins and the Remove Programs From Your Computer 
dialog box appears. The uninstall program enters a check by each component after it is 
removed.

6. When the uninstall program encounters a shared file that is no longer shared by other 
programs, you are asked if the shared file should be removed. If you are unsure if a 
shared file is needed, it is recommended that you do not delete the shared file.

Select one of the following options:

● Yes — This option deletes the shared file

● Yes To All — This option deletes this and all other remaining shared files

● No — This option does not delete the shared file

● No to All — This option does not delete this or any other shared files

When the uninstall is complete, the message, “Uninstall successfully completed”, 
appears at the bottom of the Remove Programs From Your Computer dialog box.

7. Select OK.

Microsoft Windows  closes the Remove Program From Your Computer dialog box.

8. Select OK.

The uninstall program closes the message box.

The uninstall removes all files and directories that were created during the CentreVu  
IP Agent installation.
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Chapter 4: Administering DEFINITY for 
CentreVu IP Agent

This section provides procedures and information on how to configure a DEFINITY  
Enterprise Communication Server (ECS) for use with CentreVu  IP Agent.

Before agents can receive calls with CentreVu  IP Agent, the DEFINITY  ECS must be 
configured to support such things as extension assignments, IP connectivity, and phone 
types.

Before you begin

You should be familiar with administrating DEFINITY  ECS before attempting any of the 
procedures in this section.

Contents

This chapter includes the following sections:

● Configuring the DEFINITY ECS on page 47

● Required DEFINITY circuit packs on page 67
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Configuring the DEFINITY ECS

This section provides the procedure on how to configure a DEFINITY  ECS for use with 
CentreVu  IP Agent.

This section contains the following topics:

● Ensuring Telecommuter and Road-Warrior compatibility on page 48

● Ensuring CALLMASTER VI compatibility\ on page 51

● Validating Feature Access Codes on page 52

● Changing station settings for Telecommuter configurations on page 54

● Changing station settings for Road-Warrior configurations on page 59

● Changing station settings for CALLMASTER VI configurations on page 64

The screenshots provided in this section are from a DEFINITY  ECS with the Expert Agent 
Selection (EAS) feature. You may notice some slight differences if your DEFINITY  does 
not have EAS. To accomodate for this, each step in the procedure requiring a distinction 
between an EAS and non-EAS system will be stated.
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Ensuring Telecommuter and Road-Warrior 
compatibility

This section provides the procedure for ensuring that your DEFINITY  ECS is configured 
to support CentreVu  IP Agent in the Telecommuter and Road-Warrior (VoIP) 
configurations.

Before you begin

The settings for IP connections can only be enabled if your DEFINITY  ECS supports use 
of Internet Protocol (IP) for calls.

Screens presented in this section may differ in appearance from those on your DEFINITY  
ECS. All options on the specified forms mentioned in this procedure are available, but may 
not be on the page noted.

! Important:
If any settings of your DEFINITY  ECS do not conform with the steps in this 
procedure, you must contact Avaya to purchase the appropriate options or 
configuration before you can use CentreVu  IP Agent.

Steps

To ensure that your DEFINITY  ECS supports the Telecommuter and Road-Warrior 
configurations:

1. Log in to the Station Administration Terminal (SAT) on the DEFINITY  ECS.

2. Enter display system-parameters customer-options.

The SAT displays Page 1 of the system-parameters customer-options form.
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3. Ensure that the Maximum Concurrently Registered IP Stations? option is set to a number 
greater than zero. This number represents the total number of IP stations that can be 
connected to the DEFINITY  system at one time. IP stations can consist of CentreVu  
IP Agent, DEFINITY  IP SoftPhone, and IP telephone sets.

4. Navigate to Page 3 of the customer-options form.

5. Ensure that the IP Stations? feature is set to y

6. Navigate to Page 6 of the customer-options form.

7. Ensure that the Logged-In IP Softphone Agents: option is set to a number greater than 
zero. This number represents the total number of agents using IP softphones that can 
be connected to the DEFINITY  system at one time.

If you have a DEFINITY  ECS release previous to R9, the following steps do not apply 
to your system.
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8. Navigate to Page 9 of the customer-options form.

9. Ensure that the Limit: field for the IP_Agent Product ID is set to the number of licenses 
you purchased for CentreVu  IP Agent.



Ensuring CALLMASTER VI compatibility\

Issue 1.2 August 2002 51

Ensuring CALLMASTER VI compatibility\
This section provides the procedure for ensuring that your DEFINITY  ECS is configured 
to support CentreVu  IP Agent in the CALLMASTER  VI configuration.

Before you begin

Screens presented in this section may differ in appearance from those on your DEFINITY  
ECS. All options on the specified forms mentioned in this procedure are available, but may 
not be on the page noted.

! Important:
If any settings of your DEFINITY  ECS do not conform with the steps in this 
procedure, you must contact Avaya to purchase the appropriate options or 
configuration before you can use CentreVu  IP Agent.

Steps

To ensure that your DEFINITY  ECS supports CentreVu  IP Agent:

1. If you are going to be using CALLMASTER  VI telephone sets or the 606A1 phone 
type, you must also ensure that the PC Application Software Translation Exchange 
(PASTE) feature is enabled. Locate the PASTE (Display PBX Data on Phone)? option and 
ensure that it is set to y.
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Validating Feature Access Codes
This section provides the procedure for administering the Feature Access Codes on a 
DEFINITY  ECS. Feature Access Codes can be utilized by CentreVu  IP Agent and 
provide agents with the ability to perform the following actions: 

● Change their current work state

● Login

● Logout 

● Adjust the method with which they receive their next call (Auto-In, Manual-In)

● Request supervisor assistance

Before you begin

Before changing Feature Access Codes on the DEFINITY  ECS, you should have 
completed the Ensuring Telecommuter and Road-Warrior compatibility on page 48 
procedure to verify that your DEFINITY  ECS supports CentreVu  IP Agent.

Feature Access Codes cannot be entered unless the fac capability is assigned in the 
dialplan.

To change settings on the DEFINITY  ECS, you must have a DEFINITY  system user ID 
with the proper administrative permissions.

! Important:
Screens presented in this section may differ in appearance from those of 
your DEFINITY  ECS. All options on the specified forms mentioned in this 
procedure are available, but may not be on the page noted.

Steps

To validate Feature Access Codes:

1. Log in to the Station Administration Terminal (SAT) on the DEFINITY  ECS.

2. Enter display dialplan to access the dialplan form and then ensure that the fac option is 
assigned in the dialplan.

If the fac option is not assigned in the dialplan, your dialplan does not currently support 
Feature Access Codes. For more information on configuring your dialplan for Feature 
Access Codes, see the Administrator’s Guide for your DEFINITY  ECS.

3. Enter display feature-access-codes to view the feature-access-codes form.
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4. Navigate to Page 4 of the feature-access-codes form.

Non-EAS DEFINITY  ECS will only display a subset of the access code fields seen in 
the following graphic.

The Feature Access Codes seen in this graphic are only an example and do not need 
to be configured as such on your DEFINITY  ECS. You are free to determine your own 
Feature Access Codes.

5. Administer the Feature Access Code for Login and Logout as well as any other FACs 
that you want available for your agents.

To use the following features the FACs associated with these features must be enabled 
and assigned:

● After Call Work (ACW)

● Auto-in answer mode

● Manual-in answer mode

● Auxiliary work state (AUX)

If Feature Access Codes are not assigned, see the Administrator’s Guide for your 
DEFINITY  ECS for instructions on adding Feature Access Codes.
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Changing station settings for Telecommuter 
configurations

This section provides the procedure for changing station settings to support the 
Telecommuter configurations.

Before you begin

Before changing station settings on the DEFINITY  ECS, you should have completed the 
Ensuring Telecommuter and Road-Warrior compatibility on page 48 and Validating Feature 
Access Codes on page 52 procedures to verify that your DEFINITY  ECS supports 
CentreVu  IP Agent and Feature Access Codes.

To change settings on the DEFINITY  ECS, you must have a DEFINITY  ECS user ID 
with the proper administrative permissions.

Steps

To change station settings to support the Telecommuter configuration:

1. Log in to the Station Administration Terminal (SAT) on the DEFINITY  ECS.

2. Enter change station XXXXX where XXXXX is the number of the station to be used with 
CentreVu  IP Agent.

The DEFINITY  ECS displays the change station form for the specified station.
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3. In the Phone Type: field, enter the type of telephone that CentreVu  IP Agent will 
emulate.

Avaya recommends using one of the following phone types because of the number of 
features available and the ability to display the most characters for contact center or 
call information.

● 8434D

● 606A1 (This phone type is not available unless you have purchased and enabled the 
PASTE feature.)

CentreVu  IP Agent can take over the administration and functionality of a real DCP 
telephone set. The physical telephone set must be one of those listed in Compatible 
phone types for CentreVu IP Agent V2 on page 21 in the Introduction section. The 
physical telephone set is unusable while CentreVu  IP Agent is registered with its 
extension. The telephone set will become usable again the CentreVu  IP Agent 
session is disconnected from the DEFINITY  system. 

If an agent does not have an on-site station with a DCP connection to the DEFINITY  
ECS and only connects to the DEFINITY  ECS remotely, the phone type is emulated 
through CentreVu  IP Agent which then provides the appropriate functionality.

If the 8434D phone type was selected and more feature buttons are needed for the 
station, enter y in the Expansion Module? field.

4. Enter one of the following options in the Port: field:

● X — This option specifies that station administration is done without hardware.

● <port> — This option is used for situations where a remote agent takes direct 
control of a real extension that has a Digital Communications Protocol (DCP) 
connection to the DEFINITY  system. Enter the port number of the actual telephone 
assigned to this extension. When a remote agent logs in to this extension using 
CentreVu  IP Agent, the actual telephone that is locally connected to the 
DEFINITY  port is disabled and cannot be used.

5. Enter a number in the Security Code: field that will be used as a password during the 
extension login to the DEFINITY  system.

If a security code is not entered, this station will not be able to log in to the DEFINITY  
ECS.

6. Set the IP Softphone? field to y.
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7. Navigate to Page 2 of the change station form.

8. Set the Multimedia Mode: field to enhanced.

9. Set the Service Link Mode: field to one of the following options:

● as-needed — Use this setting if the station has low call traffic or if you have to pay 
toll charges for calls.

● permanent — Use this setting if the station has high call traffic or if it is set as an 
auto-answer station.

10. If the Auto Answer: field is set to All or ACD on the station or agent form, you must 
enable the Enable support for auto answeroption on the PC and then reboot. You 
can find this option under Tools > Program Options in the CentreVu  IP Agent main 
window.

11. Navigate to Page 3 of the change station form.

12. On pages 3, 4, and 5 of the station administration forms, assign functions to each 
button you want to appear in your CentreVu  IP Agent Phone Features.

The following functions must be assigned to buttons:

● auto-in — This function makes agents available for new calls immediately after they 
finish with current calls.
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● manual-in — This function keeps agents from receiving calls until they change their 
state to Available (AVAIL).

● after-call — This function places agents in the After Call Work (ACW) state.

● aux-work — This function places agents in the Auxiliary Work (AUX) state. The first 
button assigned as aux-work on an EAS station with reason codes must have a 
reason code of 0 or be left blank.

A blank reason code will prompt the user to enter a reason code when the 
associated AUX button is selected.

● release — This function terminates the current call and line appearance.
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● callr-info — Used with Call Prompting to allow agents to display information 
collected from the originator.

When this station is connected to the DEFINITY  ECS, the assigned button 
functions are displayed in the CentreVu  IP Agent Phone Features window.

You can find information on all available button functions in the Administrator's Guide 
for your DEFINITY  ECS.
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Changing station settings for Road-Warrior 
configurations

This section provides the procedure for changing station settings to support Road-Warrior 
configurations.

Before you begin

Before changing station settings on the DEFINITY  ECS, you should have completed the 
Ensuring Telecommuter and Road-Warrior compatibility on page 48 and Validating Feature 
Access Codes on page 52 procedures to verify that your DEFINITY  ECS supports 
CentreVu  IP Agent and Feature Access Codes.

To change settings on the DEFINITY  ECS, you must have a DEFINITY  ECS user ID 
with the proper administrative permissions.

Steps

To change station settings to support Road-Warrior (VoIP) configurations:

1. Log in to the Station Administration Terminal (SAT) on the DEFINITY  ECS.

2. To use CentreVu  IP Agent in the Road-Warrior (VoIP) configuration, you must 
administer a Media Complex Extension which is used for the audio portion of the call.

Start the creation of a Media Complex Extension by entering add station XXXXX where 
XXXXX is a number that is not assigned to a station. This extension number must 
conform to your dialplan. If you have already created Media Complex Extensions, you 
can proceed to Step 7.

! Important:
Do not specify a Security Code for the Media Complex Extension.

3. Set the Type: field to H.323.

4. Ensure that the Port: field was automatically set to X.

5. In the Name: field, Avaya recommends that you enter a descriptive string of characters 
with “Media Complex Ext” included to simplify identification.

6. Press the <Enter> key to save your changes.
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7. Enter add station XXXXX or change station XXXXX where XXXXX is the number of the 
station to be used with CentreVu  IP Agent.

The DEFINITY  ECS displays the change station form for the specified station.

8. In the Phone Type: field, enter the type of telephone that CentreVu  IP Agent will 
emulate.

Avaya recommends using one of the following phone types because of the number of 
features available and the ability to display the most characters for contact center or 
call information.

● 8434D

● 606A1 (This phone type is not available unless you have purchased and enabled the 
PASTE feature.)

CentreVu  IP Agent can take over the administration and functionality of a real DCP 
telephone set. The physical telephone set must be one of those listed in Compatible 
phone types for CentreVu IP Agent V2 on page 21 in Introduction. The physical 
telephone set is unusable while CentreVu  IP Agent is registered with its extension. 
The telephone set will become usable again the CentreVu  IP Agent session is 
disconnected from the DEFINITY  system. 

If an agent does not have an on-site station with a DCP connection to the DEFINITY  
ECS and only connects to the DEFINITY  ECS remotely, the phone type is emulated 
through CentreVu  IP Agent which then provides the appropriate functionality.

If the 8434D phone type was selected and more feature buttons are needed for the 
station, enter y in the Expansion Module? field.

9. Enter one of the following options in the Port: field:

● X — This option specifies that station administration is done without hardware.

● <port> — This option is used for situations where a remote agent takes direct 
control of a real phone that has a Digital Communications Protocol (DCP) 
connection to the DEFINITY  ECS. Enter the port number of the actual phone 
assigned to this extension.
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10. Enter a number in the Security Code: field that will be used as a password during the 
extension login to the DEFINITY  system.

If a security code is not entered, this station will not be able to log in to the DEFINITY  
ECS.

11. Set the Media Complex Ext: field to the number of the station that you created earlier in 
Step 2.

12. Set the IP Softphone? field to y.

13. Navigate to Page 2 of the change station form.

14. Set the Service Link Mode: field to one of the following options:

● as-needed — Use this setting if the station has low call traffic or if you have to pay 
toll charges for calls.

● permanent — Use this setting if the station has high call traffic or if it is set as an 
auto-answer station.

15. Set the Multimedia Mode: field to enhanced.

16. If the Auto Answer: field is set to All or ACD on the station or agent form, you must 
enable the Enable support for auto answeroption on the PC and then reboot. You 
can find this option under Tools > Program Options in the CentreVu  IP Agent main 
window.
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17. Navigate to Page 3 of the change station form.

18. On pages 3, 4, and 5 of the station administration forms, assign functions to each 
button you want to appear in your CentreVu  IP Agent Phone Features.

The following functions must be assigned to buttons:

● auto-in — This function makes agents available for new calls immediately after they 
finish with current calls.

● manual-in — This function keeps agents from receiving calls until they change their 
state to Available (AVAIL).

● after-call — This function places agents in the After Call Work (ACW) state.

● aux-work — This function places agents in the Auxiliary Work (AUX) state. The first 
button assigned as aux-work on an EAS station with reason codes must have a 
reason code of 0 or be left blank.

A blank reason code will prompt the user to enter a reason code when the 
associated AUX button is selected.

● release — This function terminates the current call and line appearance.
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● callr-info — Used with Call Prompting to allow agents to display information 
collected from the originator.

When this station is connected to the DEFINITY  ECS, the assigned button functions 
are displayed in the CentreVu  IP Agent Phone Features window.

You can find information on all available button functions in the Administrator's Guide 
for your DEFINITY  ECS.



Administering DEFINITY for CentreVu IP Agent

64 CentreVu IP Agent Installation and User Guide

Changing station settings for CALLMASTER VI 
configurations

This section provides the procedure for changing station settings to support the 
CALLMASTER  VI configurations for CentreVu  IP Agent.

Before you begin

Before changing station settings on the DEFINITY  ECS, you should have completed the 
Ensuring Telecommuter and Road-Warrior compatibility on page 48 and Validating Feature 
Access Codes on page 52 procedures to verify that your DEFINITY  ECS supports 
CentreVu  IP Agent and Feature Access Codes.

To use CALLMASTER  VI telephone sets, you must have the PASTE feature enabled on 
your DEFINITY  ECS.

To change settings on the DEFINITY  ECS, you must have a DEFINITY  ECS user ID 
with the proper administrative permissions.

Steps

To change station settings to support CALLMASTER  VI configurations:

1. Log in to the Station Administration Terminal (SAT) on the DEFINITY  ECS.

2. Enter change station XXXXX where XXXXX is the number of the station to be used with 
CentreVu  IP Agent.

The DEFINITY  ECS displays the change station form for the specified extension.

3. In the Type: field, enter 606A1.

4. In the Port: field, enter the number of the port providing the connection for the 
CALLMASTER  VI telephone set.

5. Navigate to Page 3 of the change station form.

6. On pages 3, 4, 5, and 6 of the station administration forms, assign functions to each 
button you want to appear in your CentreVu  IP Agent Phone Features.

The following functions must be assigned to buttons:

● auto-in — This function makes agents available for new calls immediately after they 
finish with current calls.

● manual-in — This function keeps agents from receiving calls until they change their 
state to Available (AVAIL).

● after-call — This function places agents in the After Call Work (ACW) state.
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● aux-work — This function places agents in the Auxiliary Work (AUX) state. The first 
button assigned as aux-work on an EAS station with reason codes must have a 
reason code of 0 or be left blank.

A blank reason code will prompt the user to enter a reason code when the 
associated AUX button is selected.

● release — This function terminates the current call and line appearance.
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● callr-info — Used with Call Prompting to allow agents to display information 
collected from the originator.

When this station is connected to the DEFINITY  ECS, the assigned button functions 
are displayed in the CentreVu  IP Agent Phone Features window.

You can find information on all available button functions in the Administrator's Guide 
for your DEFINITY  ECS.

7. After you create a station and assign or modify buttons, you must perform a download 
for the CALLMASTER  VI. Go to the PC connected to the CALLMASTER  VI station 
and select Settings > Phone Configuration from the CentreVu  IP Agent menu bar.

CentreVu  IP Agent displays a confirmation dialog.

8. Select OK.
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Required DEFINITY circuit packs

This section provides information on the circuit packs required for your DEFINITY  ECS so 
that it supports the Telecommuter and Road-Warrior configurations with CentreVu  IP 
Agent.

This section contains the Circuit pack descriptions and associated documentation topic
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Circuit pack descriptions and associated 
documentation

This section provides descriptions and lists documentation resources for the circuit packs 
required on a DEFINITY  ECS for use with CentreVu  IP Agent. 

The following two circuit packs are used for remote agent connections over TCP/IP with 
CentreVu  IP Agent:

● Control LAN Circuit Pack (C-LAN) (TN799B or greater)

● IP Media Processor (TN2302AP)

C-LAN circuit pack

C-LAN is a packet port circuit pack for DEFINITY  systems that provides TCP/IP 
connectivity to adjuncts for applications. It has one 10baseT Ethernet connection and up to 
16 DS0 physical interfaces for PPP connections. Two integrated modems provide remote 
PPP connectivity over analog facilities. Multiple C-LAN circuit packs can be added to a 
system to increase TCP/IP capacity.

This circuit pack provides data signaling over TCP/IP for CentreVu  IP Agent. It is used for 
the Telecommuter and Road-Warrior configurations where a data connection is made to 
the DEFINITY  system. The voice path does not use this circuit pack.

IP Media Processor

The IP Media Processor provides the transmission of voice data over an IP network. This 
enables support of applications that comply with the H.323-v2 protocols. It also reduces 
per-port costs and improves quality through its dynamic jitter buffers. Additionally, it 
performs echo cancellation, silence suppression, Dual Tone Multi-Frequency (DTMF) 
detection, and conferencing. 

This circuit pack provides voice over TCP/IP for CentreVu  IP Agent. Is is used for the 
Road-Warrior configuration where a Voice over Internet Protocol (VoIP) is made to the 
DEFINITY  ECS.

Documentation

For installation procedures and configuration information for the C-LAN circuit pack, see 
the DEFINITY  Administration for Network Connectivity document for your DEFINITY  
ECS.
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The DEFINITY  ECS Installation, Upgrades and Additions for Compact Modular Cabinets 
document for your DEFINITY  ECS provides installation and configuration information for 
the IP Media Processor circuit pack. It also provides helpful information on setup and 
configuration with a C-LAN circuit pack.
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Chapter 5: Running CentreVu IP Agent

This chapter explains how to begin using CentreVu IP Agent. It contains the following 
section:

● Starting and exiting on page 73
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Starting and exiting

This section explains how to connect to your company’s Local Area Network (LAN) and 
how to complete the DEFINITY Login window. Then it tells you how to log into agent mode.

Introduction

Before you can use CentreVu IP Agent as a telephone, you need to first establish 
connectivity to your company’s LAN (Local Area Network) where the DEFINITY server 
resides. Then you need to register your extension with the DEFINITY server by completing 
the DEFINITY ECS Login window.

After you are registered with the DEFINITY ECS, you have an operating telephone and 
can now make, receive, conference, and transfer calls. However, in order to make yourself 
available for ACD calls, you need to perform an Agent login.

In this section

This section includes the following information:

● Starting CentreVu IP Agent on page 74

● Logging into the DEFINITY ECS on page 75

● Logging into CentreVu IP Agent on page 79

● Exiting CentreVu IP Agent on page 81
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Starting CentreVu IP Agent

Procedure

To start CentreVu IP Agent, do the following:

1. Select Start from the taskbar.

2. Go to Programs from the Start menu.

3. Go to Avaya CentreVu IP Agent.

4. Select CentreVu IP Agent in the language of your choice.

The DEFINITY Login and the CentreVu IP Agent windows appear. Although IP Agent 
is now running, you are not yet logged into the DEFINITY server.

5. Go to Logging into the DEFINITY ECS on page 75.
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Logging into the DEFINITY ECS
Before you can use CentreVu IP Agent, you need to log on to the DEFINITY ECS.

Procedure

To log into the DEFINITY server, follow these steps:

1. When you start CentreVu IP Agent, the DEFINITY Login window appears. If the Login 
window does not open, select File and then select Login from the CentreVu IP Agent 
window.

The DEFINITY Login screen appears.

2. In the Extension box, enter your extension on the DEFINITY server.

3. In the Password box, enter your password.

4. If you want the software to save your password for the next time you log into the 
DEFINITY server, enable the “Remember password for next login” check box.

5. Do one of the following:

● If you have logged into the DEFINITY server before, go to Step 7.

● If this is the first time you are logging into the DEFINITY ECS, continue with Step 6.
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6. In the Server area, enter the DEFINITY node name or IP address for the DEFINITY 
server, as follows:

● If you want to enter the node name, click the DEFINITY Node Name option button, 
and enter the domain name for the DEFINITY server.

● If you want to enter the IP address, click the IP address option button, and enter the 
IP address for the DEFINITY server.

Contact your DEFINITY System Administrator for this information.

! Important:
You will not be able to run CentreVu IP Agent with an extension that was 
registered as an DEFINITY IP Softphone endpoint. If the extension was 
registered as a DEFINITY IP Softphone endpoint, you will have to log out 
and exit the registration program. Then, you will have start CentreVu IP 
Agent and log in again.

7. In the Voice Connection area, do one of the following:

● If you want to use the information displayed, go to Step 8.

● If you want to change the information displayed, go to Configuring the voice 
connection on page 77.

8. In the Dialing From: area, click the Properties button to set the dialing properties (such 
as the country and area code) for the DEFINITY system you are logging into.

9. If you want the system to log into the DEFINITY server automatically the next time you 
start CentreVu IP Agent, enable the “Automatically login if possible when application 
restarts” check box. You must have logged into the ACD one time before you can use 
the automatic login option.

The DEFINITY® Login screen displays the information you selected.
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10. Click Log In. When you successfully log into the DEFINITY server, the system displays 
the Login Established dialog box, and CentreVu IP Agent starts.

! Important:
If you are using the Telecommuter configuration, the system displays the 
Verify Telephone Number dialog box. It is very important that you make 
some test calls before logging in to verify that you have set up your 
connection properly.

Configuring the voice connection

The Voice Connection dialog box lets you specify whether you want to use CentreVu IP 
Agent in the RoadWarrior configuration (Voice over IP) (that is, use DEFINITY iClarity IP 
Audio to hear and speak to the other party on a call) or the Telecommuter configuration 
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(Dual Connection) (that is, use a telephone on a separate telephone line to hear and speak 
to the other party on a call). To select the appropriate Voice Connection:

1. In the Voice Connection dialog box, click the Change button. 

The system displays the Voice Connection Configuration dialog box.

2. Do one of the following:

● If you want to use CentreVu IP Agent in the RoadWarrior configuration, select the 
DEFINITY iClarity IP Audio option button. In this configuration, DEFINITY iClarity IP 
Audio is the H.323 application you will use to hear and speak to the other party on a 
call. 

● If you want to use CentreVu IP Agent in the Telecommuter configuration, select the 
Telephone at option button and enter the telephone number of the telephone you 
will use to hear and speak to the other party on a call.

3. If you selected the DEFINITY iClarity IP Audio option, specify how your PC connects to 
the DEFINITY server by setting the network bandwidth setting . 

4. If you selected the Telephone at option, enter the telephone number of the telephone 
you want to use. 

You will use the handset (or speakerphone) on this telephone to hear and speak to the 
other party on a call. Be sure to enter this telephone number the way you would dial it 
from your DEFINITY extension. For example, if the telephone number is an outside call 
in the same area code as your DEFINITY extension and you must dial a 9 when 
making outside calls, you would enter 9 at the beginning of the telephone number in 
this box.
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Logging into CentreVu IP Agent
After logging into the DEFINITY server, you will need to log into CentreVu IP Agent in order 
to receive ACD (Automatic Call Distribution) calls. 

Procedure

To log into the program, use the following procedures:

1. In the CentreVu IP Agent window, click the Login button.

The Agent Login dialog box appears.

2.  In the Agent Login dialog box, enter your Agent number and Password.

3. Click Login. As soon as you click Login, your voice phone rings.

! Important:
If you do not answer your phone immediately or if you entered the wrong 
number for the voice connection, the following message will appear: “Your 
call could not be completed. Please try again.” You will have to click OK and 
log in again.

4. Depending on how your DEFINITY ECS is administered, you will be allowed to do 
either of the following:
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● After you have answered the initial call, leave your phone off hook, and your phone 
line will stay open. This setting is called “permanent.”

● After you have answered the initial call, hang up, leaving your phone on hook. This 
means that each time a call is received or made, your phone will ring. This setting is 
called “as needed.”

The buttons on the Agent toolbar are highlighted, and the title bar displays the Agent 
number. 

5. To get out of AUX work mode, click either the Auto-In or Manual-In button.

For more information about Auto-In and Manual-In work modes, see Selecting your 
work mode on page 84.

6. You are now ready to begin receiving and making calls.
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Exiting CentreVu IP Agent

Procedure

This procedure tells you how to exit CentreVu IP Agent and log out of the DEFINITY 
server.

1. To log out of the program, click the Logout button.

2. Depending on your DEFINITY ECS administration, you may be required to enter a 
reason code. See Using Reason Codes..

3. In the CentreVu IP Agent menu bar, select the File menu and then select Exit.
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Chapter 6: CentreVu IP Agent basics

This chapter contains information on the basic operations of CentreVu  IP Agent.

This chapter includes the following sections:

● Handling incoming calls on page 84

● Transferring a call on page 87

● Conferencing calls on page 91

● Handling outgoing calls on page 95

● Handling outgoing calls on page 95

● Logging into and out of CentreVu IP Agent on page 99
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Handling incoming calls 
Handling Incoming Calls describes those functions that you will be using every day when 
you receive an incoming call at your station, including answering a call, holding a call, 
releasing a call, and transferring a call. The following functions must be administered on 
the DEFINITY ECS for your station in order to work. 

Selecting your work mode

You can elect to set your incoming calls for Auto-In mode or Manual-In mode by selecting 
the mode in the Agent toolbar. If you are in Auto-In mode, when you complete a call, you 
are automatically available to receive another call, or you may be placed in After Call Work 
(ACW) mode for an administered length of time. When the timed ACW interval expires, you 
are automatically returned to the Auto-In mode. If you try to change agent modes while 
active on a call, the change is not made until you disconnect from the call.

If you are in Manual-In mode, when you complete a call, you are automatically placed in 
After Call Work (ACW) mode. In order to become available to receive another ACD call, 
you must manually enter the Auto-In or Manual-In mode. If you try to change agent modes 
while not active on a call, the change takes place immediately.

Answering a call

Answering a call depends on how the DEFINITY ECS and network is administered. Each 
Call Center environment is different, which can affect the way you answer calls. It is 
suggested that each Call Center evaluate its configuration and instruct the agent on the 
best way to answer the CentreVu IP Agent phone. There are too many possible CentreVu 
IP Agent configurations for Lucent to support all of them. Below are suggested procedures 
on answering calls for two specific configurations. 

Configuration 1

Agent administration for Auto Answer is set to station or none. Station Administration for 
Auto Answer is set to none. Station Administration has service link set to “as-needed.” 

Each time a call is received, the analog phone set that provides the voice path will ring, as 
will the computer, depending upon the CentreVu IP Agent option settings.

To answer a call for this configuration:

1. Wait for the analog phone to ring and answer it. Answering the analog phone will 
automatically answer the call on the CentreVu IP Agent screen. If there is another call 
ringing on the screen, do not hang up the analog phone, click the answer button on the 
CentreVu IP Agent screen and you are now connected to this call. 
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2. After the calling party disconnects from the call or you click release for that call, hang 
up the analog phone if no more calls are ringing on the CentreVu IP Agent screen.

3. If there is another call ringing on the screen, do not hang up the analog phone. Click 
the answer button on the CentreVu IP Agent screen and you are now connected to this 
call. 

Configuration 2

Agent administration for Auto Answer is set to station, ACD, or all. Station Administration 
for Auto Answer is set to ACD or all. Station Administration has the service link set to 
“permanent”.

During the event of Agent login, your analog phone will ring to deliver the login 
confirmation tone.

To answer a call for this configuration:

1. You should answer the phone and not hang it up for the remainder of your Agent shift.

2. If the phone accidentally gets cut off or hung up, the DEFINITY ECS will ring the 
analog phone when it has a call to deliver. You will then need to answer the analog 
phone.

3.  As with any auto answer phone, the DEFINITY ECS will provide a zip tone (a beep) 
signaling that a new call has arrived.

Holding a call

You can put a call on hold by using either the Auto Hold or Manual Hold feature.

1. To manually put a call on hold, click the Hold button on the Phone Button toolbar.

The button on your CIP changes to Reconnect.

2. You can manually answer a second call while on an active call without having to put 
the first call on hold. The first call will automatically be put on hold when you answer 
the second call regardless of whether the Auto Hold or Manual Hold feature is 
administered for your station.
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Releasing a Call

There are three methods you can use to release a call. These methods will work only if the 
release feature has been administered for your station.

1. To release a call, do one of the following:

● While on an active call, click the Release button located on the CIP. You will not hear 
a dial tone after you press Release.

● Click the Release button located on the Phone Button toolbar.

● Press the space bar on your keyboard.

2. If you have a call on hold, you must first reconnect it before you can release the call.

In the example below, you would have to reconnect extension 1048 before you could 
release it.

Dropping a Call

Use the Drop feature when you want to disconnect from a normal call or drop the last party 
added to a conference call.

1. To drop a call, click the Drop button located on the Phone Button toolbar.

2. You are disconnected from the call and hear a dial tone.
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Transferring a call
Transferring a Call describes the following three methods of transferring calls:

● Basic Transfer lets you send the present call to another extension or outside number. 
You select Transfer, dial the number, announce the call, and select Transfer again.

● Unsupervised Transfer differs from a Basic Transfer in that you select Transfer, type the 
number to be called into a text box, and click OK to transfer the call. You do not 
announce the call.

● Enhanced Transfer differs from a Basic Transfer in that you select Transfer, type the 
number to be called into a text box, and click OK. After announcing the call, you can 
either click Yes to transfer or No to not transfer the call.

Tip: The Transfer button can be configured for basic, unsupervised, or enhanced transfer 
in the Options dialog box. However, you can choose a type of transfer different than that 
configured by selecting the Call menu and then selecting Transfer.
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Basic Transfer

To transfer a call using Basic Transfer, follow these steps:

1. While you are active on a call, select Call from the menu bar. Then select Transfer and 
Basic Transfer.

The current call will automatically be put on hold and a new CIP will appear with dial 
tone.

2. Enter the number of the party you want to transfer the call to. The numbers are entered 
using the keyboard or Dial Pad.

3. When the second call is answered, you can privately talk to the party; then select Basic 
Transfer again to complete the transfer.

Tip: You may complete the transfer at anytime after the number is entered, during the 
ringing state, or after the second party answers.

Both CIPs disappear from your main callbar indicating that the transfer was successful.

4. You may change the call transfer into a conference by selecting Basic Conference 
instead of Basic Transfer in Step 3.

5. If there is no answer, the line is busy, or you decide the transfer is not needed, do the 
following to cancel the transfer:

● Click the Release button for the party that was going to receive the transfer. This will 
release that call. 

● Return to the held call by selecting the call state Reconnect button for that held call.
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Unsupervised Transfer

To transfer a call using Unsupervised Transfer, follow these steps:

1. While you are active on a call, select Call from the menu bar. Then select Transfer and 
Unsupervised Transfer.

The Unsupervised Transfer box appears.

2. In the Unsupervised Transfer box, enter the number you want to transfer your existing 
call to. The number must be typed in, or it can be copied and pasted in.

3. Click OK to transfer the call. You do not have to click the Transfer button a second time 
to complete the transfer.

The CIP will disappear from your main callbar, indicating that the transfer was 
successful.

Enhanced Transfer

To transfer a call using Enhanced Transfer, follow these steps:

1. While you are active on a call, select Call from the menu bar. Then select Transfer and 
Enhanced Transfer.

The Enhanced Transfer box appears.
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2. In the Enhanced Transfer box, enter the number you want to transfer your existing 
caller to.

! Important:
The number must be typed in, or it can be copied and pasted in.

3. Click OK. The caller will automatically be put on hold and a new CIP will appear with 
dial tone.

The Transfer the Party? box appears.

4. Remain on the line. If the number dialed is answered, announce the call. Then click the 
Yes button in the Transfer the Party? box.

Both CIPs disappear from your main callbar indicating that the transfer was successful.

5. If the number dialed is not answered or is busy, click the No button in the “Transfer the 
Party?” box. Click the Reconnect button to return to the held call.

6. When finished, hang up or click the Drop button.
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Conferencing calls
Using Conferencing describes the following two methods of handling conference calls:

● Basic Conference lets you add another party to a call. You select Conference, dial the 
number, talk to the party to be added to the conference, and select Conference again.

● Enhanced Conference differs from a Basic Conference in that you select Conference, 
type the number of the party to be added into a text box, and click OK. After talking to 
the party, you can either click Yes to add or No to not add the party to the call.

Tip: The Conference button can be configured for basic or enhanced conference in the 
Options dialog box. However, you can override this configuration. Just select Call on the 
menu bar and then select the method of conferencing you prefer.

For more information on call conferencing, see Call menu on page 106.

Basic Conference

To conference a call using Basic Conference, follow these steps:

1. While you are active on the call to be conferenced, select Call from the menu bar. Then 
select Conference and Basic Conference. 

The caller will automatically be put on hold and a new CIP will appear with dial tone.

2. Enter the number of the party you want to add to the call conference. The numbers are 
entered using the keyboard or the Dial Pad. 
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3. When the second call is answered, you can privately talk to the party; then select Basic 
Conference again to initiate the conference call. 

Tip: You may initiate the conference at any time after the number is entered, during the 
ringing state, or after the second party answers.

One CIP appears on your main callbar displaying "CONFERENCE 2" (indicating an 
active conference).

4. You may change the call conference into a transfer by selecting Basic Transfer instead 
of Basic Conference in Step 3.

5. Repeat Step 1 through Step 3 until you have conferenced all parties.

The single CIP will display "CONFERENCE X," where X equals the number of parties 
you added to the call.

If you added three parties to the call, the display on the CIP will say "CONFERENCE 
3."

6. If there is no answer, the line is busy, or you decide the conference is not needed, do 
the following: 

● Click the Release button for the party that was going to be added to the conference. 
This will release that call.

● Return to the held call by selecting the call state Reconnect button for that held call.



Conferencing calls

Issue 1.2 August 2002 93

Enhanced Conference

To add another person to a call, or conference a call, follow these steps:

1. While you are on an active call, select Call.

The Call menu appears.

2. From the Call menu, select Conference and then Enhanced Conference.

The Enhanced Conference Number box appears.

3. In the Enhanced Conference Number box, enter the number of the party you want to 
add to the call.

! Important:
The number must be typed in, or it can be copied and pasted in.

4. Click OK. The caller will automatically be put on hold and a new CIP will appear with 
dial tone.

The “Add Party to call?” box appears.
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5. Remain on the line. If the number dialed is answered, you can privately talk to the 
party. Then click the Yes button in the “Add Party to call?” box to add the party to the 
call.

One CIP appears on your main callbar displaying "CONFERENCE 2" (indicating an 
active conference).

6. If the number dialed is not answered or is busy, click the No button in the “Add Party to 
call?” box. Click the Reconnect button to return to the original party.

7. Repeat Step 1 through Step 6 until you have conferenced all parties.

The single CIP will display “CONFERENCE X”, where X equals the number of parties 
you added to the call.

If you added three parties to the call, the display on the CIP will say “CONFERENCE 
3”.

8. Any person on the conference call can hang up at any time. The CIP will display 
"CONFERENCE X," where X equals the number of parties left on the call. 

9. To disconnect the last person added to the conference call, click the Drop button.

10. When the conference call is over, click the Release button.

 The CIP will disappear from the main callbar.
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Handling outgoing calls
There are several ways you can make the handling of outgoing calls more efficient. You 
can use a recent calls list, a speed dial number, or an abbreviated dial button.

Using a Recent Calls List

You can quickly dial or redial recent incoming or outgoing calls by using a recent calls list. 
Phone numbers are not duplicated in the list, so if the last ten calls are to the same 
number, the number will only be displayed in the list once. Calls are only added to the list if 
they contain a valid phone number.

Some points to know about the recent calls list are:

● You or your system administrator can control the number of recent call numbers 
displayed by setting the number in the Options dialog box. 

● The list may show the last 25 unique numbers recorded in the Call History log. Numbers 
from other sources (abbreviated dial buttons or numbers dialed on active calls (pin 
numbers) are not included in the list.

● Letters dialed (for example, 1800ABCDXYZ) will appear in the recent calls list as 
entered, and not as the number translation.

Procedure

To make a call using the Recent Calls list:

1. Click the down arrow next to the Call History button. 

A list of previously dialed or previously received numbers appears.
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2. Click the number you want to dial.

The CIP will look like the following example:

3. The phone number is sent and the called phone will start ringing.

Administering Speed Dialing

CentreVu IP Agent lets you determine speed dial numbers in the Phone Directory 
Properties dialog box. A speed dial number can be any number in the Phone Directory, up 
to a maximum of 25 numbers. To use speed dialing, follow these steps:

1. In the CentreVu IP Agent main window, click the Phone Directory button.

The Phone Directory dialog box appears. Here is an example of a Phone Directory.

2. In the Phone Directory menu, do one of the following:

● If you are creating an entry, click the New Entry button.

● If you are editing an entry, highlight the entry. Select View and then select 
Properties.

The Properties dialog box appears.
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3. Enter or edit the appropriate information in the Properties dialog box fields.

! Important:
For more information on the Phone Directory and Phone Directory 
Properties dialog boxes, see Using the Phone Directory..

4. Check the Speed Dial button next to the phone number that you want to administer as 
a speed dial number.

5. Click OK.

6. To use a speed dial number, in the CentreVu IP Agent main window, click the down 
arrow next to the Phone Directory button.

The speed dial list appears.

7. Click the number you want to dial.

8. The phone number is sent and the called phone will start ringing.
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Using an Abbreviated Dial Button

If the Abbreviated Dial feature has been administered on the DEFINITY ECS for your 
physical station terminal, you can store selected telephone numbers in the Phone Features 
dialog box for quicker and easier dialing. Each number can be a complete or partial 
telephone number, an extension number, or a trunk or feature code. To make a call using 
an Abbreviated Dial button, follow these steps:

1. In the Phone Features dialog box, click the Abbreviated Dial button containing the 
number you want to dial.

The digits of the phone number will appear in the display area of the CIP.

Tip: The button label for an abbreviated dial is a number (for example, 51008); and the 
button label for an auto dial button is autodial plus the number (for example, autodial 
51008).

2. The phone number is sent and the called phone will start ringing.
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Logging into and out of CentreVu IP Agent

Quick reference

Use these procedures to log into and out of CentreVu IP Agent.

1. To log into CentreVu IP Agent, click the Login button.

2. Enter your virtual Extension and Password on the DEFINITY Login window. You need 
your IP Address or host name and the call back number for the voice connection.

3. Click the Log In button.

4. If CentreVu IP Agent doesn’t log in, select File and then select DEFINITY Login in the 
CentreVu IP Agent window.

5. To log in as an agent, first make sure the phone next to your computer is hung up. 
Click the gold key (Agent Login button) or press Ctrl+Insert. Enter your Agent ID and 
Password, and then press the Enter key. 

6. The phone next to your computer rings. Answer the call and you will hear the 
confirmation tone. The Agent buttons on the CentreVu IP Agent window light up. 

7. To start taking calls, click the Auto-In button (gold phone with arrow) or press Ctrl+I.

8. To take your break, click the arrow associated with the AUX button (blue cup), and 
select the reason code, if appropriate.

9. To log out, click the Agent Logout button (gold key with arrow) and enter the logoff 
reason number code, if appropriate.
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Chapter 7: Dialog Reference

This section provides descriptions of the graphical interfaces used in CentreVu  IP Agent 
and their basic functionality.

This section contains the following topics:

● Main window and menus on page 103

● CentreVu IP Agent option dialogs on page 117

● Audio dialogs on page 129
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Main window and menus

This section describes the menus and panels in the CentreVu  IP Agent main window.

This section includes the following topics:

● Menu bar on page 104

● Toolbars on page 113

● Information panels on page 116
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Menu bar
This section provides descriptions and additional information on the items and features 
found in the menu bar of the CentreVu  IP Agent window:

This section contains the following topics:

● File menu on page 105

● Edit menu on page 106

● Call menu on page 106

● View menu on page 107

● Agent menu on page 109

● Tools menu on page 110

● Audio menu on page 111

● Settings Menu on page 112

● Help menu on page 112

The CentreVu  IP Agent main window provides full-function, multi-line telephony support 
on your PC. This window is also used to access all the features found in CentreVu  IP 
Agent.

This section defines all of the items available in the CentreVu  IP Agent menus. Some 
menu items only appear when they are valid for your current configuration. For example, 
the Call menu item is not available in an IP Endpoint configuration when a call is not 
currently active. Other menu items and buttons on the interface will be disabled when their 
functionality cannot be intiated at that time because of configuration, call instance, or agent 
state.



Menu bar

Issue 1.2 August 2002 105

File menu

The following items are available on the File menu item:

● Login, Logout, DEFINITY Login, or DEFINITY Logout — These items appear as the 
first item in this menu and are used for logging the station or agent in and out of the 
DEFINITY  ECS.

● Import Settings — This menu item gives you the ability to open a file containing 
settings from another CentreVu  IP Agent installation and apply those settings to this 
installation.

● Export Settings — This menu item will save the settings from this installation of 
CentreVu  IP Agent and save them to a file. This file can then be re-imported to this PC 
or to another PC with CentreVu  IP Agent.

● Exit — Performs the necessary logouts for the agent and the DEFINITY  ECS and 
closes CentreVu  IP Agent.

Imported and exported settings

Imported and exported files include the all of the following settings:

● All settings available in the Program Options window

● Screen pops

● Lightweight Directory Access Protocol (LDAP) servers and settings

● Personal Phone features

● Phone features

● Abbreviated Dialing settings

● Call Centre features

● Telephone button labels

● Audio settings

● Speed-dial settings
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Edit menu

The following items are available on the Edit menu:

● Cut — Removes any highlighted text in the Number: field and places it on the Windows 
clipboard.

● Copy — Copies any highlighted text in the Number: field and places it on the Windows 
clipboard.

● Paste — Retrieves the last item placed on the Windows clipboard and places it in the 
Number: field.

Call menu

The Call menu is only visible when a call is made or received.

The following items are available on the Call menu:

● Release — Terminates an active call.

● Drop — Disconnects from a call without requiring you to hang up the handset, turn off 
the speakerphone, or press the switchhook.

● Hold — Places a call on hold until you can return to it. While the call is on hold, you can 
place another call, activate a feature, or answer another call.

● Transfer — Sends a call from your extension to another extension or outside number. 
Use this feature when the other party on the call need to speak with someone else. 
There are three different types of transfers available. See Transfer types on page 107 in 
this section for more information.
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● Conference — Allows you to add other parties to a call There are two different types of 
transfers available. See Conference types on page 107 in this section for more 
information.

Transfer types

The following types of call transfers are available with CentreVu  IP Agent:

● Basic Transfer — Select Transfer, dial the number, announce the call, and select 
Transfer again.

● Unsupervised Transfer — Select Transfer, enter the number to be called in the 
displayed dialog, and select OK to transfer the call. You are not able to talk to the party 
receiving the transferred call with this type of transfer.

● Enhanced Transfer — Select Transfer, enter the number to be called in the displayed 
dialog, and select OK. You can announce the call and then, in the displayed message 
box, select Yes to complete the transfer or No to cancel the transfer.

Conference types

The following types of call conferencing are available with CentreVu  IP Agent:

● Basic Conference — Select Conference which displays another call appearance. Dial 
the number of the party to add to the conference, announce the conference to the new 
party, and select Conference again to add the new party.

● Enhanced Conference — Select Conference which displays a dialog box, enter the 
number to call in the appropriate field, and select OK. After announcing the conference 
to the new party, select Yes from the displayed message box to add the new party.

View menu

The following items are available on the View menu:

● Phone Display — Enabling this item displays a panel above the status bar. This panel 
can display information from sources such as VuStats or call-prompting digits.



Dialog Reference

108 CentreVu IP Agent Installation and User Guide

● Dial Pad — Enabling this item displays a DialPad window which contains a series of 
numbers and symbols arranged like those on a telephone keypad. You can use your 
mouse to dial numbers on the Dial Pad. 

● Toolbars > Show Labels — Enabling this item displays labels for the buttons on the 
Phone Buttons toolbar on page 113 and the Agent toolbar on page 114.

● Toolbars > Phone Buttons — Enabling this item displays the Phone Buttons toolbar on 
page 113 which contains buttons for the Drop, Transfer, Conference, and Hold 
functions.

● Toolbars > Dial Number — Enabling this item displays the Dial Number toolbar on 
page 114 which provides a field for entering digits as well as the buttons used to access 
the call history, the phone directory, the DialPad, and the public directory search.

● Toolbars > Audio Control — Enabling this item displays the Audio toolbar on page 114 
which allows the user to enable or disable audio transmission, audio receiving, and the 
headset. This toolbar is only available for Road-Warrior (VoIP) configurations.

● Toolbars > Agent — Enabling this item displays the Agent toolbar on page 114 which 
an agent can use to change their work states as well as a Login/Logout button.

● Toolbars > Agent Greetings — Enabling this item displays the Agent Greetings 
toolbar on page 114 which is used to select, play, and stop agent greetings that have 
been previously recorded. This toolbar is only available for the Road-Warrior (VoIP) and 
CALLMASTER  VI configurations.

● Headset — Enabling this item displays the Headset toolbar on page 115 which contains 
a button for answering a call or creating a new call appearance when a call is not 
currently active.

● Status Bar — Enabling this item displays the Status Bar at the bottom of the CentreVu  
IP Agent main window. The Status Bar is used to display different types of information 
such as current activity, notification of voice messages, the state of CentreVu  IP Agent, 
tooltips, and others.
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Agent menu

The following items are available on the Agent menu:

● Agent Login — This item displays the Agent Login dialog box for entering your EAS 
Agent login ID number and password.

● Agent Logout — This item enables you to log out so that calls are not routed to this 
extension.

● Auto-In Mode — This is an Automatic Call Distribution (ACD) work mode. Agents in the 
Auto-In mode are available to receive new calls as soon as their current call is released.

● Manual-In Mode — This is an ACD work mode. Agents in the Manual-In mode cannot 
receive new calls until they manually change their state to Available.

● After Call Work (ACW) — This is an ACD work mode indicating that an agent is 
performing tasks related to their last call.

● Auxiliary Work Mode (AUX) — This is an ACD work mode indicated that an agent is 
not available to receive an ACD call. Depending on how the ACD is administered, the 
AUX work state can require that agents provide a reason code before the state can be 
assigned.

● Assist — This item causes a request for assistance from a skill supervisor.
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Tools menu

The following items are available on the Tools menu:

● Phone Features — Selecting this item displays the Phone Features window which lists 
all feature buttons that have been assigned to this station.

● Personal Phone Features — Selecting this item displays the Personal Phone 
Features window which is used to create a smaller list of Phone Features that are used 
often or for ease of access.

● Call History — Selecting this item displays the Call History window which shows the 
history of all calls received by this station including calling party name, calling party 
number, date, time, duration, and call notes.

● Phone Directory — Selecting this item displays the Phone Directory window which is 
used to store names, addresses, phone numbers, and other information.

● Search Public Directory — Selecting this item displays the Search Public Directory 
window which allows the searching of LDAP servers by name, telephone number, or e-
mail address.

● Screen Pops — Selecting this item displays the Screen Pops window which lists all of 
the screen pops that exist on this PC.

● Agent Greetings — Selecting this item displays the Agent Greetings window which 
lists all of the agent greetings that exist on this PC. This item is only available for the 
Road-Warrior (VoIP) and CALLMASTER  VI configurations.

● VuStats Monitor — Selecting this item displays the VuStats Monitor window. This 
window is used to view the VuStats information being sent to this station.

● Program Options — Selecting this item displays the Program Options dialog for 
CentreVu  IP Agent.
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Audio menu

! Important:
The Audio menu is only available for Road-Warrior (VoIP) configurations.

The following items are available on the Audio menu:

● Audio Monitor — Selecting this item displays the Audio Meters window which displays 
the audio levels currently used for your microphone and speakers.

● Volume Setting — Selecting this item displays the Audio Settings window which allows 
you to verify that your headset is operating properly and to adjust the volume of the 
headset and microphone.

● Audio Status — Selecting this item displays the Audio Status window which allows 
you to verify that your microphone and speakers are operating properly.

● Audio Options — Selecting this item displays the Audio Options window which allows 
you to adjust the settings for IP audio such as bandwidth, full- or half-duplex, and gain 
levels.

● Tuning Wizard — Selecting this item runs the Tuning Wizard which queries the PC for 
the optimal settings for Voice over IP.
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Settings Menu

The following items are available on the Settings menu:

● Dialing Properties — Selecting this item displays the Windows Dialing Properties 
dialog box. This dialog box is used to configure number formats, telephony drivers, and 
special dialing requirements.

Help menu

The following items are available on the Help menu:

● Contents — Selecting this item displays the table of contents for CentreVu  IP Agent 
online help.

● About CentreVu IP Agent — Selecting this item displays the About dialog box which 
provides product information for CentreVu  IP Agent.
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Toolbars
This section provides descriptions and additional information on the toolbars of the 
CentreVu  IP Agent window: Toolbars contain buttons that provide quick access to specific 
commands and tools. Toolbars can be added or removed from the main window, by 
selecting each one in the View menu on page 107.

This section contains the following topics:

● Toolbar locations on page 113

● Phone Buttons toolbar on page 113

● Dial Number toolbar on page 114

● Agent toolbar on page 114

● Agent Greetings toolbar on page 114

● Audio toolbar on page 114

● Headset toolbar on page 115

Toolbar locations

Each toolbar can be moved to any location in the main window.

To move a toolbar:

1. Move the mouse pointer on the far-left side of the toolbar until the mouse pointer 
changes its appearance to the resizing icon.

2. Click and hold the left mouse button.

3. Drag the toolbar to the necessary location. The toolbar will change positions as you 
move it over different areas of the main window.

4. When the toolbar is correctly positioned in its new location, release the left mouse 
button.

Phone Buttons toolbar

The Phone Button toolbar provides quick access to the basic phone buttons: Hold, Drop, 
Transfer, and Conference.

The Transfer and Conference buttons provide drop-down lists allowing the agent to select 
the type of transfer or conference to make.
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Dial Number toolbar

The Dial Number toolbar provides a Number: field for entering telephone numbers to 
dial. When you enter a partial string in the Number: text box and press the <Enter> key or 
click the telephone button on the right side of the field, a popup menu displays with a list of 
the directory entries that start with that string. For example, entering 555 and pressing 
<Enter> will show all telephone numbers in the Phone Directory that start with 555; 555–
555–1212, 555–123–4567. 

If the first character of the string entered in this field is a letter, the title of the field will be 
changed from Number to Directory.

This toolbar also provides single-click for the following:

● DialPad window

● Phone Directory window

● Speed-dial drop-down list

● Call History window

● Recent call drop-down list

● Search Public Directory window

Agent toolbar

The Agent toolbar provides buttons for agent login and logout and agent states for 
DEFINITY  ECS with Expert Agent Selection (EAS).

Agent Greetings toolbar

The Agent Greetings toolbar lets you select, play, and stop greetings. This toolbar is only 
available for Road-Warrior (VoIP) and CALLMASTER  VI configurations.

Audio toolbar

The Audio toolbar allows control of the following areas:

● microphone status and volume
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● speaker status and volume

● headset status

This toolbar is only available in the Road-Warrior (VoIP) configuration.

Headset toolbar

The Headset toolbar contains a button used to toggle the headset or handset on or off 
hook.
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Information panels
This section contains descriptions and information on the areas of the main window that 
display information to the user.

There are three different types of panels in CentreVu  IP Agent:

● Call Information Panel on page 116

● Agent Information Panel on page 116

● Phone Display Panel on page 116

Call Information Panel

CentreVu  IP Agent displays the Call Information Panel only during incoming and 
outgoing calls. It provides information about the call, such as call status, call display, call 
duration, and an Answer/ Release/ Reconnect button. 

If a call is currently active and it is listed in the Phone Directory, the name for that contact 
in the Phone Directory will be listed in this panel instead of the information passed from 
the ACD.

The call status, incoming, outgoing, or on-hold, is displayed in the first section. Click the 
right mouse button on this panel to display a popup menu containing available options for 
this call, such as hold, transfer, and conference.

Agent Information Panel

CentreVu  IP Agent displays the Agent Information Panel when there are no calls and 
agent status information is available. If you are logged in, the status information also 
includes the agent mode state.

Phone Display Panel

The Phone Display panel is a 40-character display that is located above the Status Bar. 
This display area is updated automatically with information from the DEFINITY  ECS 
including call and non-call related information, such as call-prompting digits, VuStats data, 
and the local date and time display from the ACD. 
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CentreVu IP Agent option dialogs

Use the Program Options dialog to configure the many feature areas of CentreVu  IP 
Agent. Select Tools > Program Options... to display this dialog.

This section contains descriptions for the following CentreVu  IP Agent dialogs:

● General Settings on page 118

● ACD Agent on page 119

● Call Handling on page 120

● Call History on page 121

● Call Information Display on page 122

● Database Location on page 123

● Sound Effects on page 123

● User Interface Options on page 124

● External Number Format on page 125

● Event Logging on page 126

● Voice Message Number on page 126

● Feature Access on page 127
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Program Options

General Settings

The General Settings dialog contains the following items:

● Automatically login to the DEFINITY Server. — When this check box is enabled, 
CentreVu  IP Agent will attempt to log in to the DEFINITY  server when it is started. It 
will use the information that was last used for a successful login to the DEFINITY  
server.

● Enable support for auto-answer. — When this check box is enabled, CentreVu  IP 
Agent will attempt to automatically connect an incoming call without requiring that the 
agent pick up the handset or click the Answer or headset buttons on the main window. 
For this feature to function, the station must be configured for auto-answer on the 
DEFINITY  server.

● Handle voice call request from other programs — When this check box is enabled, 
CentreVu  IP Agent intercepts requests from other applications on the PC to begin a 
call and functions as if the call was started through CentreVu  IP Agent.

● PASTE Feature Access Code: — This field is used to re-enter the PC Application 
Software Translation Exchange (PASTE) code for a CALLMASTER  VI unit. This code, 
which is found on the DEFINITY  server, allows the CALLMASTER  VI unit to translate 
information sent from the DEFINITY  server to CentreVu  IP Agent. This option is only 
available for CALLMASTER configurations.
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ACD Agent

The ACD Agent dialog contains the following items:

● Configure program for EAS agent support — Enabling this check box causes 
CentreVu  IP Agent to support the Expert Agent Selection (EAS) feature for 
DEFINITY  servers.

● Prompt for agent ID and password during agent login. — Enabling this check box 
causes a dialog to be displayed when an agent requests a login to the DEFINITY  
server. The dialog prompts agents for their agent ID and their password.

● Save agent password during agent login — Enabling this check box causes 
CentreVu  IP Agent to save the password of an agent after a successful login.

● Automatically log into the ACD — Enabling this check box will cause CentreVu  IP 
Agent to attempt to automatically log in the agent to the DEFINITY  server after the 
station has successfully registered with the DEFINITY  server.
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Call Handling

The Call Handling dialog contains the following items:

● Call Transfer - Use Basic Transfer — Selecting this option sets the default transfer 
mode to the basic style.

● Call Transfer - Use Unsupervised Transfer — Selecting this option sets the default 
transfer mode to the unsupervised style.

● Call Transfer - Use Enhanced Transfer — Selecting this option sets the default 
transfer mode to the enhanced style.

● Call Conferencing - Use Enhanced Conference — Enabling this check box sets the 
default conferencing mode to the enhanced style. Otherwise, CentreVu  IP Agent uses 
the basic conferencing mode.
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Call History

The Call History dialog contains the following items:

● Log incoming calls — Enabling this check box causes CentreVu  IP Agent to make a 
record of all calls received at this station in the Call History log.

● Log outgoing calls — Enabling this check box causes CentreVu  IP Agent to make a 
record of all calls made from this station in the Call History log.

● Months to keep calls in log: — Use this field to specify the length in months that call 
records are stored in the Call History log.

● Number of recent calls displayed: — Use this field to specify the number of the last 
ingoing and outgoing calls that are displayed when you click the Call History quick list on 
the Number toolbar of the main window.

● Clear history — Selecting this button will clear all call records from the Call History 
log.
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Call Information Display

The Call Information Display dialog contains the following items:

● Display call information on the title bar during a call. — Enabling this check box 
causes CentreVu  IP Agent to display information about the active call in the title bar of 
the main window.

● Replace call information with phone directory information. — Enabling this check 
box causes CentreVu  IP Agent to use information from the Phone Directory if the 
telephone number for the active call is found. If the telephone number for the active call 
is not found, the call information is sent by the DEFINITY  server.

● Display call information using Japanese font. — Enabling this check box will cause 
CentreVu  IP Agent to display all information in Japanese. This feature is only available 
if the Japanese version of CentreVu  IP Agent was installed.

● Enter the size of the font to be used to display call information on Call Information 
Panel — Use this field to select the point size of the font that CentreVu  IP Agent uses 
to display call information in the Call Information Panel on the main window.
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Database Location

The Database Location dialog contains the following items:

● Directory: — This field displays the current location of the database (Agent.mdb) that 
CentreVu  IP Agent uses to store Call History and the Phone Directory.

● Change... — Select this button to specify a different location for the CentreVu  IP Agent 
database (Agent.mdb).

Sound Effects

The Sound Effects dialog contains the following items:

● Volume: — Use this slider control to adjust the volume at which the sound effects are 
played.
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● Play ringing through internal PC speaker. — Enabling this check box causes 
CentreVu  IP Agent to play the ringing for an incoming call through the internal speaker 
on the PC instead of playing it through the speakers attached to the sound card.

● Mute ringing and sound effects. — Enabling this check box disables the playing of 
sounds generated by CentreVu  IP Agent.

User Interface Options

The User Interface Options dialog contains the following items:

● Always display the main window on top. — Enabling this check box will keep the 
CentreVu  IP Agent in front of all other windows.

● Display tooltips for toolbars. — Enabling this check box causes tooltips to appear 
when the mouse cursor is placed over buttons on the toolbars of the main window.

● Display letters on the DialPad — Enabling this check box displays the letters that 
correspond to the numbers on the number pad of a telephone.

● Incoming Calls - Display the Shortcut icon in the Windows system tray. — 
Enabling this check box displays the CentreVu  IP Agent icon in the System Tray.

● Incoming Calls - Display the main window on top of other windows for incoming 
calls. — Enabling this check box causes the main window to appear in front of any 
other application windows that are currently open when a call is incoming.

● Incoming Calls - Flash the title bar of the main window for incoming calls — 
Enabling this check box causes the title bar of the main to flash when a call is incoming. 
This resembles selection and deselection of the window.
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External Number Format

The External Number Fomat dialog contains the following items:

● Number of digits in company extensions: — Enter the number of digits that are 
dialed for station extension numbers on your DEFINITY  server.

● Maximum number of digits in city code: — Enter the number of digits that are dialed 
for telephone numbers that use a code to identify a city. This field may be disabled 
depending on the Windows dialing format currently specified.

● Minimum number of digits in phone number, including city code: — Enter the 
fewest number of digits that can be used to dial an outgoing call. This number should 
also include the code used to identify a city. This field may be disabled depending on the 
Windows dialing format currently specified.

● Maximum number of digits in phone number, including city code: — Enter the 
largest number of digits that can be used to dial an outgoing call. This number should 
also include the code used to identify a city. This field may be disabled depending on the 
Windows dialog format currently specified.

When you adjust any of the last three fields, the telephone number displayed in the text 
box at the bottom of the dialog reflects these changes.
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Event Logging

The Event Logging dialog contains the following items:

● Enable logging for IP Agent. —Enabling this check box causes CentreVu  IP Agent to 
record all activity.

● View Log — Selecting this button will display the log associated with the specific area 
designated by the options on the left side of each check box.

● Monitor — Selecting this options displays the Events Monitor window. This window 
displays all CentreVu  IP Agent internal events as they occur.

Voice Message Number

When you have voice messages waiting for you, the System Tray displays an icon. The 
options on this dialog determine what action to take when this icon is double-clicked.
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The Voice Message Number dialog contains the following items:

● Do nothing — CentreVu  IP Agent will not intiate any action when the icon in the 
System Tray is double-clicked.

● Dial this number: — When you select this option, you must provide a telephone 
number or extension to dial in the associated field. When you double-click the icon in the 
System Tray, CentreVu  IP Agent dials the number in this field.

● Use Application — When you select this option, you must provide the path and 
filename of an executable to run when you double-click the icon in the System Tray.

● Goto URL — When you select this option, you must provide a Universal Resource 
Locator (URL) address that will be displayed or run when you double-click the icon in 
the System Tray.

Feature Access

Use the Feature Access dialog to restrict users from administering or making changes to 
the various features of CentreVu  IP Agent. When any changes are made to the features, 
you must restart the computer for these restrictions to take effect.

The Feature Access dialog contains the following items:

● Feature List — Each of the CentreVu  IP Agent areas listed in this box can be protected 
from modifications. To select a feature area, click on the feature in this list.

● Disable Access — Enabling this check box restricts the user from accessing this 
feature. This option is not available for the Program Options feature. When access is 
disabled for a feature, the feature will not appear in the menus on the menu bar.

● Disable Modification — Enabling this check box restricts the user from altering the 
feature.

● Disable Selection — Enabling this check box restricts the user from activating a screen 
pop by double-clicking it in the Screen Pops window.
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● Set Password/Enter Password — Selecting this button displays the Change 
Password... dialog. When you enter a password, the options for the Feature Access 
dialog cannot be changed until the proper password is entered.
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Audio dialogs

This section provides descriptions of the Audio Options and Audio Tuning Wizard 
dialogs. These dialogs are only available for Road-Warrior (VoIP) configurations.

This section contains the following topics:

● Audio Options dialog on page 130

● Audio Tuning Wizard on page 132
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Audio Options dialog

Descriptions

The Audio Options dialog contains the following items:

● Using Headset or Handset (Full Duplex) — Select this option button if you are using a 
headphone or a handset to speak to and hear the other party on a call. This option 
button is disabled if the Audio Tuning Wizard identified a half-duplex sound card in 
your PC.

● Using PC Microphone and PC Speakers (Half Duplex) — Select this option button if 
you are using a microphone and PC speakers to speak to and hear the other party on a 
call.

● Automatic acoustic echo cancellation (Full Duplex) — Select this option button if 
you are using a microphone and PC speakers to speak to and hear the other party on a 
call. This option uses the automatic acoustic echo cancellation feature, which 
automatically attempts to "filter out" echo. This option button is disabled if the Audio 
Tuning Wizard identified a half-duplex sound card in your PC or you are using Microsoft 
Windows NT  4.0.

● Half-Duplex Sound Card — Select this option button if you have a half-duplex sound 
card in your PC. This option button is disabled if the Audio Tuning Wizard identified a 
full-duplex sound card in your PC.

● Bandwidth Settings — Select how your PC connects to the DEFINITY  server. 
CentreVu  IP Agent uses the bandwidth setting to determine which codec to use with 
the DEFINITY  server. The DEFINITY  server supports the following codecs:

— G.729a — This codec may be used for 28800 bps or better modem connection; 
Cable, xDSL, or ISDN connection; and Local Area Network connection. (This codec 
is used for low-speed connections.)



Audio Options dialog

Issue 1.2 August 2002 131

— G.723 — This codec may be used for 28800 bps or better modem connection; 
Cable, xDSL, or ISDN connection; and Local Area Network connection. (This codec 
is used for low-speed connections.)

— G.711 u-law (CCITT u-law) — This codec may be used for Cable, xDSL, or ISDN 
connection and Local Area Network connection. (This codec is used for high-speed 
connections.)

— G.711 A-law (CCITT A-law) — This codec may be used for Cable, xDSL, or ISDN 
connection and Local Area Network connection. (This codec is used for high-speed 
connections.)

When you connect to the DEFINITY  server, CentreVu  IP Agent checks the 
bandwidth setting you specified, and then determines the actual speed of the connection 
between your PC and the DEFINITY  server. CentreVu  IP Agent then selects the 
appropriate codec.

NOTE: The actual speed of the connection between your PC and the DEFINITY  server 
determines which codec CentreVu  IP Agent uses.

● Jitter Buffer — Displays the size of the jitter buffer, which stores packets to ensure a 
consistent delivery of voice to your speakers or headset so the voice stream you hear 
does not contain gaps. The larger the jitter buffer, the longer the delay receiving audio 
from the other party.

● Receive Gain — Sets the gain for incoming sound during a call. It is recommended that 
this setting be between 0.1 – 100.0.

● Transmit Gain — Set the gain for outgoing sound during a call. It is recommended that 
this setting be between 0.1 — 10.0.

● Audio Receive Clarity — Adjusts the clarity for incoming sound during a call.

● Suppress Silence — Sets whether silence packets are transmitted when there is 
silence.

● Comfort Noise — Sets whether you want DEFINITY  iClarity IP Audio to generate 
noise for you when the other party is not speaking. This noise indicates to you that the 
call is still active.
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Audio Tuning Wizard

Descriptions

The Audio Tuning Wizard is a program that will detect the hardware and settings for your 
PC. It will also have you test the levels for your microphone and speakers for optimum 
performance. Each dialog of the Audio Tuning Wizard provides complete instructions on 
the tasks to be performed and are not descr4ibed here for that reason.
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Appendix A:  Quick Reference: Shortcut keys

This appendix contains quick reference information for shortcut keys.

Shortcut keys refer to key combinations that you can use to invoke a particular command. 
For example, to place a call on hold, you can press <Ctrl> + <H>. Some of the most 
commonly used shortcut keys are discussed in this section. In order for shortcut keys to 
work as documented, the CentreVu  IP Agent window must have focus as the current 
application.
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Shortcut keys

Call features

The following table provides the shortcut keys for call features:

Agent features

The following table provides the shortcut keys for the CentreVu  IP Agent window:

To... Press...

Place a call on hold <Ctrl>+<H>

Transfer a call <Ctrl>+<T> to dial the number and then 
again to transfer the call

Conference another party <Ctrl>+<F> to dial the number and then 
again to conference the call.

To... Press...

Log in <Ctrl>+<Ins>

Log out <Ctrl>+<Del>

Change to After Call Work (ACW) state <Ctrl>+<W>

Change to Auxiliary (AUX) state <Ctrl>+<A>

Change Available state assignment to 
automatic (Auto-In)

<Ctrl><I>

Change Available state assignment to 
manual (Manual-In)

<Ctrl>+<M>

Request supervisor assistance (Assist) <Ctrl>+<S>
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CentreVu® IP Agent features

The following table provides the shortcut keys for the CentreVu  IP Agent window:

Windows® features

The following table provides the shortcut keys for the CentreVu  IP Agent window:

To... Press...

Display the Call History window <Alt>+<C>

Display the Phone Directory window <Alt>+<D>

Release the current call <Spacebar>

Display online help <F1>

Exit CentreVu  IP Agent <Alt>+<F4>

To... Press...

Switch between running applications <Alt>+<Tab>

Cut selected text to the clipboard <Ctrl>+<X>

Copy the selected text to the clipboard <Ctrl>+<C>

Paste clipboard contents to the selected 
area

<Ctrl>+<V>
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Appendix B:  Quick Reference: Language 
Support

This appendix contains quick reference information for supported languages.
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Supported languages for CentreVu IP Agent

CentreVu IP Agent languages table

This table shows the versions of CentreVu  IP Agent that are supported with the specific 
language versions of the operating systems. An X indicates that the operating system is 
supported.
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US English only CentreVu IP Agent components

The following CentreVu  IP Agent components are provided only in English:

● Installation

● About screen

● Event log

● CentreVu  IP Agent internal files

● Shortcut keys for secondary callbars

● readme.txt file 

● Uninstall program
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Appendix C:  Quick Reference: 
Troubleshooting

This appendix contains information for troubleshooting problems with CentreVu  IP Agent. 

More Information

If the problem you are experiencing cannot be found in this section, the most current and 
up-to-date technical support information for CentreVu IP Agent can be found at 
http://support.avaya.com. Select Call Center/CRM and then the appropriate links under 
the IP Agent group.

http://support.avaya.com
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Troubleshooting

Problem What to do

Cannot register with the DEFINITY  ECS. Check for a valid configuration.

The following are not supported:

CentreVu  IP Agent does not support 
Network Address Translation (NAT), Port 
Address Translation (PAT), or unsupported 
Virtual Private Network (VPN).

A DEFINITY  ECS prior to release 8.2 
cannot be used for the Telecommuter or 
Road-Warrior configurations.

A DEFINITY  ECS prior to release 6.2 
cannot be used for the CALLMASTER  VI 
configuration.

Agents cannot log in to EAS. Ensure that the following administration 
items have been addressed:

Feature Access Codes are administered.

If you are using a Road-Warrior (VoIP) 
configuration, ensure that an IP Media 
Processor has been properly configured so 
that Road-Warrior (VoIP) configurations 
can operate properly.

If the DEFINITY  ECS has the station set 
for Auto-answer, ensure that CentreVu  IP 
Agent has the Enable support for auto 
answer option enabled.

Agents are logged off repeatedly of EAS or 
the DEFINITY  ECS.

Ensure that the network is not having 
stability problems or failures in service.
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Agents cannot place calls.

Ensure that the agent is logged in.

Check the Windows Dialing Properties to 
rule out improper number formatting. 
Dialing rules must conform to the dialing 
rules of the country in which the 
DEFINITY  ECS resides.

Ensure that calling cards are not being 
used.

Agent cannot be heard by other party.

Ensure that a defective sound card or 
microphone is not being used.

Ensure that the sound cardis configured 
properly through Windows.

Ensure that excessive background or PC 
noises are not preventing voice 
transmission.

Adjust the gain levels when using full-
duplex mode in a noisy environment.

Ensure that the mic or headset is not 
muted.

Excessive bandwidth usage in Voice over 
IP configurations when not actively on calls.

Change the Service Link Mode: from 
permanent to as-needed. 

Agents cannot establish calls. Ensure that an improper codec is not in 
use.

Ensure that the bandwidth of the network 
can support the bandwidth required for 
Voice over IP.

Problem What to do



Quick Reference: Troubleshooting

144 CentreVu IP Agent Installation and User Guide

The voice quality of the agent is poor with 
Voice over IP.

Check to see if the iClarity Status screen 
displays a high number of dropped packets 
and a low number of discarded packets. 
This indicates an inadequate sound card in 
the PC.

Check to see if the iClarity Status screen 
displays an equal number of dropped and 
discarded packets. This indicates problems 
with network bandwidth.

If the iClarity Status screen displays the 
correct information, run the Tuning Wizard 
again. It can be found under the Audio 
menu item. The Tuning Wizard cannot be 
run while the transmit and receive are 
active. To deactivate the transmit and 
receive channels, you can either log the 
station out of the DEFINITY  ECS or 
change the station settings from the 
DEFINITY  ECS to use the as-needed 
option for the Service Link Mode: field 
instead of permanent.

The voice quality of the other party is poor 
when using Voice over IP.

Lower the gain setting on the microphone.

Set the Jitter Buffer in the Audio Options 
to Automatic. 

Receiving and transmitting audio is 
delayed.

Perform one of the following actions:

Ensure that your DEFINITY  ECS is 
optimized to handle “shuffling” and 
“hairpinning” for Voice over IP. Consult your 
DEFINITY  documentation for more 
information.

Lower the Jitter Buffer in the Audio 
Options.

Receiving echo and poor voice quality while 
using Voice over IP.

If you are using speakers and a 
microphone instead of a headset, change 
to half-duplex in the Audio Options 
window. Using separate speakers and a 
microphone can cause feedback situations.

Problem What to do
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Collected digit informattion is not displayed. You must have a callr-info button assigned 
for non-CALLMASTER telephones so that 
collected digit information is displayed. 
Buttons are configured for stations through 
the change station command on the 
DEFINITY  ECS.

Ensure that VuStats is deactivated. This 
can be done by double-clicking on the 
Normal Mode button in the Phone 
Features window.

In Telecommuter mode, picking up the 
handset does not automatically answer the 
incoming call displayed in the CentreVu  IP 
Agent window.

Ensure that the Service Link Mode: for the 
station is set to as-needed.

Ensure that the Enable support for auto-
answer option is disabled. This option is 
found in the Program Options in 
CentreVu  IP Agent. If this option is 
enabled, disable it and then reboot your 
PC.

Ensure that the Multimedia Call Handling 
(Enhanced) option on the DEFINITY  ECS 
is set to y. This option can be found on the 
system-parameters customer-options form. If 
this option is not set to y, contact Avaya 
technical support or your Avaya 
representative for assistance.

The call information panel is not displaying 
any data.

This can occur if you are emulating a phone 
type that is normally configured to display 
40 characters of information and it is 
currently in use because of VuStats, Q-call, 
or it is already busy with information from 
another incoming call. You can either 
change the phone type emulation to one 
that displays 80 characters of information or 
disable VuStats so that the call information 
panel is not committed to displaying this 
information. See Compatible phone types 
for CentreVu IP Agent V2 on page 21 in the 
Introduction section for telephone sets that 
support 80 character displays.

You changed your login extension but the 
DEFINITY  does not recognize your login.

Reboot your PC and attempt the login 
procedure again.

Problem What to do
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The settings for one CentreVu  IP Agent 
installation were exported, but the import 
did not seem to work on another 
workstation.

Ensure that you are not trying to use 
exported settings from a CentreVu  IP 
Agent installation on another operating 
system. Setting exports from an operating 
system such as Microsoft Windows NT  
4.0 cannot be imported on a different 
operating system such as Microsoft 
Windows  98. Also, if one CentreVu  IP 
Agent installation is configured for 
CALLMASTER  VI, those settings cannot 
be imported to a CentreVu  IP Agent 
installation with an IP Endpoint 
configuration.

The button feature assignments were 
changed for this station, but the 
assignments do not display in CentreVu  
IP Agent or fail to work.

Refresh the phone features. For 
CALLMASTER  VI configurations, select 
Settings > Phone Configuration from the 
menu bar. For IP Endpoint configurations, 
exit and restart CentreVu  IP Agent.

The phone download for the 
CALLMASTER  VI failed.

Enter the PASTE code again for the 
CALLMASTER  VI so that the DEFINITY  
ECS sends the updates to the station. 
Select Tools > Program Options and 
enter the number in the PASTE Feature 
Access Code: field.

The agent does not seem to be logged in 
because all of the icons are still disabled.

Verify the following configuration items:

On the DEFINITY  ECS, verify that the 
station has the following features assigned 
to buttons: Auto-in, Manual-in, After Call 
Work (ACW), and Auxiliary Work (AUX).

On the DEFINITY  ECS, verify that the first 
AUX work button assigned to the station 
has a blank reason code or a reason code 
of 0.

Agent logs in but is immediately logged out. If the station or agent is administered on the 
DEFINITY  ECS as auto answer, Enable 
support for auto answer in the Program 
Options must be enabled in CentreVu  IP 
Agent. After changing this setting in 
CentreVu  IP Agent, you must reboot the 
PC for the change to take effect. 

Problem What to do
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The agent is unable to record greetings. Attempt the action appropriate for your 
configuration:

For CALLMASTER  VI configurations, 
check to see if the headset button in the 
Greetings window is activated. If so, click 
on the button to deactivate it and try to 
record the greeting again. The headset can 
also be deactivated through the headset 
button on the CALLMASTER  VI unit. 

For Road-Warrior (VoIP) configurations, the 
recording of agent greetings can only be 
done when the transmit and receive audio 
connections are inactive. You can logoff 
and restart CentreVu  IP Agent to record 
agent greetings, but the first call instance 
that occurs will once again disable the 
ability to record agent greetings.

For telecommuter configurations, agent 
greetings are not supported.

I do not know how to stop the transmit and 
receive audio traffic?

Read the following items for the solution for 
your configuration:

If the Service Link Mode: for this station is set 
to permanent, the transmission and receipt 
of audio over the network is only inactive 
when the agent first logs in. The first call 
that occurs on this station will cause the 
audio traffic to begin and remain active until 
the station is logged off of the DEFINITY  
system. 

If the Service Link Mode: for this station is set 
to as-needed, the audio link will become 
inactive 10 seconds after release of a call.

Fatal errors occuring when the Call History 
window is opened.

This could be a sign that the IP Agent 
database is corrupt. To resolve this 
problem, uninstall IP Agent and reinstall. 
Any data stored in the database previous to 
this action is lost.

Problem What to do
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Glossary

Abbreviated Dial Feature Allows the agent to store selected telephone numbers for quicker and easier dialing. 
Each number can be a complete or partial telephone number, an extension number, 
or a trunk or feature code.

ACD See Automatic Call Distribution.

Active Call A call appearance state where the voice (talk) path between two parties has been 
connected; for example, a caller and an agent.

ACW See After Call Work

Add/Remove Programs A Windows feature that allows you to remove programs that have been installed on 
your computer. The Add/Remove icon is found in the Control Panel dialog box.

After Call Work (ACW) An ACD agent work mode in which agents are unavailable to receive ACD calls. 
Agents should enter the ACW mode to wrap-up call-related work before the next 
ACD call is delivered.

Agent A person who receives calls that are directed to a split or skill.

Agent Information Panel This panel is displayed when there are no calls and there is status information. If the 
agent is logged in, the status information also includes the agent mode (for example, 
Auto-In and Manual-In).

Agent Mode The agent skill set associated with your EAS agent ID. To use IP Agent, you need to 
log into agent mode in order to receive ACD (Automatic Call Distribution) calls. 
Logging into agent mode makes the Agent toolbar available for your use.

Agent Skill An attribute that is associated with an EAS ACD agent. Agent skills can be thought 
of as the ability for an agent with a particular set of skills to handle a call that requires 
one of a set of skills. An agent can be assigned up to 20 skills. The meaning of each 
Agent Skill is defined by the customer. Examples of what could be considered skills 
are: the ability to speak a particular language or the expertise to handle a certain 
product.

Agent State A feature of agent call handling. Agent states are the different call work modes and 
call states an agent can be in (logins, logouts, After Call Work, AUX, and so forth). 
Data about these states is displayed in the history log.

Agent Toolbar A toolbar that provides buttons for agent login and logout and agent modes, such as 
Auto-In, Manual-In, and After Call Work.
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Application Folder A folder on the network server that holds IP Agent application software-executable 
files and components.

Assist Allows an agent to request assistance (whether on an active ACD call or not) from 
the split or skill supervisor by pressing the Assist button or by putting the call on hold 
and dialing the Assist feature access code, followed by the split group number. The 
agent must be logged into the split.

Auto Dial A modem feature that opens the line and dials the telephone number of another 
computer to establish connection.

Auto-In An ACD work mode. In the Auto-In mode, when an agent disconnects from a call, he 
or she is automatically available to receive another ACD call.

Automatic Call 
Distribution (ACD)

A method of call distribution where EAS agents are placed called “skills.” An EAS 
agent can be logged into up to 20 skills simultaneously. For each skill, EAS 
distributes calls to the agents' voice terminals by using one of two call distribution 
methods: UCD or Expert Agent Distribution (EAD).

AutoPlay A Microsoft Windows  feature that causes an application on a CD-ROM to run 
without any user interaction as soon as the CD-ROM is inserted into the drive.

AUX See Auxiliary Work. 

AUX RC See Auxiliary Reason Code. 

Auxiliary Reason Code 
(AUX RC)

An EAS feature that enables a call center to track an agent's time more precisely 
when the agent is in the AUX state. A customer-defined numeric code that describes 
the reason for entering the AUX work state, such as lunch or meetings.

Auxiliary Work 
(AUX)Mode

An ACD agent work mode indicating the agent is unavailable (for example, on break 
or in training) to receive an ACD call.

Available An agent state in which the extension is able to accept an ACD call. This is a 
substate of Auto-In and Manual-In mode.

Basic Conference Allows an agent to add parties to a call (up to five parties can be added, for a total of 
six on the call). The agent selects Conference, dials the number, talks to the party, 
and selects Conference again. See also Enhanced Conference. 

Basic Transfer A transfer option that lets the agent send the present call to another phone number 
or extension. The agent remains on the line until the call is answered and announces 
the call if desired. See also Enhanced Transfer and Unsupervised Transfer.

Call Appearance The call appearance is an IP Agent graphical control that provides the agent with a 
Call Information Panel and a Phone Display area. See Call Information Panel and 
Phone Display.
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Call Information Panel  The Call Information Panel (CIP) is a single panel (40-character display) that 
provides information about a single call, such as name, call duration, status icon, 
and control buttons (for example, Answer/Release and Reconnect).

Call Park To park a call for retrieval at any extension.

Call Pickup To answer a call to a member of your pickup group when your voice terminal is idle.

Call Prompting A switch feature that routes incoming calls based on information entered by the 
calling party, such as an account number. The caller is prompted to select an option 
from those listed in an announcement.

Connected A trunk state in which a caller and an agent are connected on an ACD call.

Cut-Through Dialing As a digit is entered, it is immediately dialed (as on a telephone). Cut-through dialing 
is provided using the Dial Pad or by entering digits from the keyboard when focus is 
not on the Number text box.

DDE See Dynamic Data Exchange.

DEFINITY  ECS DEFINITY  Enterprise Communications Server. The DEFINITY  ECS is a 
telecommunications system that routes voice and data information between various 
endpoints (for example, telephones, terminals, and computers), provides highly 
robust networking capabilities, includes an extensive set of standard features (for 
example, Attendant Consoles, Voice Processing Interface, Call Coverage, DS1/E1 
Connectivity, Hospitality Support, Recorded Announcement, and Trunk-to-Trunk 
Transfer), and provides flexibility. It also allows for the addition of optional features 
and upgrades to the system as business needs change.

DEFINITY  IP Softphone DEFINITY  IP Softphone enables agents to log into their company’s DEFINITY  
server remotely and make and receive telephone calls from their telephone 
extensions.

Delimited Text File A file containing values separated by commas, tabs, semicolons, or other 
characters.   

Dial Area A frame located on the CentreVu IP Agent main window that provides dialing 
capabilities.

Dial Pad A toolbar that displays the 12 characters that are on the telephone dialpad. The 12 
buttons are used to dial a number. Each character clicked is automatically sent. This 
is called cut-through dialing.

Dial Number Button A button (telephone icon) on the Dial Number toolbar that is used to get a dial tone 
(for cut-through dialing) or to dial the digits entered in the Number text box 
(senderized dialing). 
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Dial Number Toolbar A toolbar that provides a number text box access to the phone directory, call history, 
speed dial, and recent calls list. When an agent enters a string (for example, lan) 
followed by Enter, a popup menu displays with a list of the directory entries that start 
with that string.  If the first character of the number is a letter, the title of the field will 
be changed from Number to Directory.

DNS See Domain Naming System.

Domain A subnetwork comprised of a group of clients and servers under the control of one 
security database.

Domain Naming System 
(DNS)

Software that lets users locate computers on the Internet by host name. The DNS 
server maintains a database of host names and IP addresses.

Drop Allows you to disconnect from an ACD call or non-ACD call. Drop disconnects you 
from a call and gives you a dial tone. Use Drop when you want to disconnect from a 
call and place another call. You can also use Drop to disconnect the last person 
added to a conference call.

Dynamic Data Exchange 
(DDE)

A message protocol in Windows that allows application programs to request and 
exchange data between them automatically.

EAS See Expert Agent Selection.

Enhanced Conference Allows you to add parties (up to six) to a call. You select Conference, type the 
number to be called into a text box, and click OK. After talking to the party, you can 
either click Yes to add the party or No to not add the party to the call. See also Basic 
Conference.

Enhanced Transfer A transfer option that lets you send the present call to another phone number or 
extension. You select Conference, type the number to be called into a text box, and 
click OK. You are provided with an “Transfer the party?” text box in which you can 
select Yes to transfer the party or No to not transfer the party. See also Basic 
Transfer and Unsupervised Transfer.

Eurofont A font set provided in DCP terminals that contains characters with diacritical marks 
common to other languages. Eurofont includes characters from the Russian, Greek, 
Baltic Rim, and central European languages, as well as the first 127 characters of 
the standard ANSI table. The True Type Font encoding used for Eurofont is non-
standard relative to the encoding used in other Windows fonts. As a result, IP Agent 
is able to support Eurofont characters in the displays received from the DEFINITY 
ECS.

Expert Agent Selection 
(EAS)

An optional DEFINITY ECS feature that builds on the power of the Call Vectoring 
and ACD features of the DEFINITY ECS to match skills required to handle a 
particular call to an agent who has at least one of the skills that a caller requires. 
Agents are assigned a single set of work mode buttons, rather than one set per split.
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FAC See Feature Access Code.

Feature Access Code 
(FAC)

A 1-to-4 digit number with an optional leading * or # that is assigned in DEFINITY 
ECS administration to invoke features. For example, *81 may invoke Service 
Observing Listen Only. FACs require an available call appearance with dial tone 
before the FAC can be sent to the DEFINITY ECS. Assigned FACs may not be 
available to all users on DEFINITY ECS based on his/her class of restrictions and/or 
whether the feature has been enabled in the DEFINITY ECS.

Feature Button A button placed on the main window that can be assigned to any one of a number of  
DEFINITY ECS features that could be assigned to a physical extension’s button 
during station administration.

Graphical User Interface 
(GUI)

This is a picture based, rather than command-line based, interaction between the 
user and the computer.

Grayed Out When you do not have access to a menu or action list item, it will be grayed out (that 
is, dimmed or displayed in a different color from the rest of the menu or action list).

GUI See Graphical User Interface.

Hold Allows an agent to disconnect from a call temporarily, use the toolbar for other call 
purposes, and then return to the original call.

HTML See HyperText Markup Language.

Hypertext A linkage between related text. For example, if you select a word in a sentence, 
information about that word is retrieved if it exists, or the next occurrence of the word 
is found.

HyperText Markup 
Language

HTML. A standard for defining documents with hypertext links. See also Hypertext.

Installation Folder A folder on the network that holds all of the IP Agent files. Setup.exe is run from this 
folder to install IP Agent on each computer. 

Internet Protocol 
Address (IP Address)

Each computer has its own unique IP address which is an identifier used for 
communicating across a network.

IP Address See Internet Protocol Address.

Kanafont A font set provided in DCP terminals that contains Katakana characters (used in 
Japanese language) as well as the first 127 characters of the standard ANSI table. 
The True Type Font encoding is non-standard relative to the encoding used on other 
DEFINITY fonts. As a result, IP Agent is able to support Katakana characters in 
displays received from the DEFINITY ECS. 
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LAN See Local Area Network.

Local Area Network 
(LAN)

A private interactive communication network that allows computers to communicate 
over short distances at high data transfer rates.

Log A file that contains a record of computer activity as well as backup and recovery 
data. 

Login Allows an agent to log into the DEFINITY ECS so that the agent can receive ACD 
calls. Non-EAS agents may log in to a maximum of four splits at once. EAS agents 
can be logged into as many as 20 skills simultaneously.

Login ID A login number and that allows an EAS agent to log into agent mode and the skills 
associated with that mode on the switch.

Logout Allows you to log out of the DEFINITY ECS. When the you out of the DEFINITY 
ECS, you cannot receive ACD calls. If you are an EAS agent, you may be requested 
to enter a reason code before logging out.

Manual-In An ACD work mode. In the Manual-In mode, the agent automatically enters the ACW 
mode when he or she disconnects from an ACD call. To become available to receive 
another ACD call, the agent must manually enter the Auto-In or Manual-In mode.

Network Server A computer in a network shared by multiple users.

Off-Hook Off-hook means that the voice path to your telephone is fully functional.

On-Hook On-hook means that the voice path to your telephone is turned off.

Phone Display A 40-character display that is located under the Call Information Panel of your 
CentreVu IP Agent callbar. This display area receives information from the 
DEFINITY ECS  so that you can see call and non-call related information,  such as 
call prompting digits and VuStats from the DEFINITY ECS.

PSTN See Public Switched Telephone Network.

Public Switched 
Telephone Network 
(PSTN)

The worldwide voice telephone network.

RC See Reason Code.

Readme File A file that provides the latest information on a newly released product; in this case, 
CentreVu IP Agent.

Read-only A folder or file that can be read, but not updated or erased.
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Reason Code (RC) A customer-defined numeric code that describes the reason for entering the AUX 
work state or for logging out of the system.

Registry The system-wide depository of information supported by Windows. The registry 
contains information about the system and its applications, including clients and 
servers.

Release Allows you to release an ACD call.

Screen Pop The ability to automatically display information from other sources, such as 
databases or Web pages based on an IP Agent triggering criteria.

Send All Calls To send all incoming calls (except priority, intercom, and personal central office calls) 
immediately to an assigned extension, AUDIX, or message center for coverage.

Senderized Dialing When a dial string is entered, the Send Digits button or Enter key must be selected 
to actually dial the digits. This type of dialing allows for editing of dial strings before 
sending the digits.

Skill An attribute that is assigned to an ACD Agent. Agent Skills can be thought of as the 
ability for an Agent with a particular set of skills to handle a call that requires one of 
those skills.

Softphone A software application that enables you to control telephone calls (both incoming and 
outgoing) directly from your computer.

Split A group of extensions that receives special-purpose calls in an efficient, cost-
effective manner. Normally, calls to a split arrive primarily over one or a few trunk 
groups.

Stroke Counts Allows an agent to record the number of times a particular customer-related event 
occurs. For example, an agent may be asked to press a button each time a customer 
requests information about a particular item. Stroke Count entries are numbered 
from 1 through 9. Each number is assigned to a specific item, and the agent enters 
that number (1–Stroke through 9–Stroke) whenever a customer asks about that item.

Switch A private switching system providing voice-only or voice and data communications 
services including access to public and private networks) for a group of terminals 
within a customer's premises.

TAPI Assisted Dialing IP Agent supports telephony enabled applications such as Microsoft Scheduler. This 
support provides the ability for telephony enabled Windows applications to originate 
a call and have the call reflected in the IP agent application.

Toolbar A row of buttons used to activate various functions of the IP Agent application. The 
IP Agent main window can contain as many as five toolbars.
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ToolTips Brief descriptions that display when the mouse pointer is over a toolbar button.

Unsupervised Transfer A call transfer option that lets an agent send the present call to another phone 
number or extension. The agent selects Transfer, types the number to be called into 
a text box, and clicks OK to transfer the call. The agent does not talk to the party 
receiving the transferred call. See also Basic Transfer and Enhanced Transfer.

VDN of Origin 
Announcement (VOA)

A short announcement that is assigned to a VDN through switch administration. The 
VOA identifies the origin or purpose of a call for the call center agent who answers 
the call.

VOA See VDN of Origin Announcement.

Voice Terminal A telephone equipped with specifically designed features (for example, the 
Conference or Hold button or Message light) and functional capabilities that 
distinguish it from a conventional telephone.

VuStats Information such as agent, split/skill, VDN, or trunk group data.
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